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CUSTOMER RESOURCE OPTIONS 

Supporting users throughout their entire journey of learning model-based systems engineering (MBSE) is 
central to Vitech’s mission. For users looking for additional resources outside of this document, please refer 
to the links below. Alternatively, all links may be found at www.vitechcorp.com/online-resources/. 

 
Webinars 

Immense, on-demand library of 
webinar recordings, including 
systems engineering industry 
and tool-specific content. 

 
 

Screencasts 
Short videos to guide users 
through installation and usage of 
GENESYS.  

 
A Primer for Model-Based 

Systems Engineering 
Our free eBook and our most 
popular resource for new and 
experienced practitioners alike. 

   

 
Help Files 

Searchable online access to 
GENESYS help files. 

 
Technical Papers  

Library of technical and white 
papers for download, authored 
by Vitech systems engineers. 

 
Technical Support 

Frequently Asked Questions 
(FAQ), support-ticket web form, 
and information regarding email, 
phone, and chat support options.  

  

https://www.vitechcorp.com/online-resources/
https://www.vitechcorp.com/webinar-videos-on-demand/
https://www.vitechcorp.com/genesys-screencasts-on-demand/
https://www.vitechcorp.com/mbse-primer/
https://www.vitechcorp.com/mbse-primer/
https://www.vitechcorp.com/resources/GENESYS/onlinehelp/desktop/
https://www.vitechcorp.com/technical-papers/
https://www.vitechcorp.com/technical-support/
http://www.vitechcorp.com/webinars
http://www.vitechcorp.com/screencasts
http://www.vitechcorp.com/mbseprimer
http://www.vitechcorp.com/resources/GENESYS/onlinehelp/desktop/
http://www.vitechcorp.com/technicalpapers
http://www.vitechcorp.com/MySupport/support/default.aspx
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1. GETTING STARTED WITH GENESYS 
This section provides an overview of GENESYS: 

• Benefits 
• GENESYS Product Family 
• Key Concepts 

The Benefits of GENESYS  
Welcome to the GENESYS Guided Tour. This guided tour is intended to familiarize you with basic features 
of GENESYS, the premier integrated systems engineering tool available today. 

The GENESYS Product Suite is a fully integrated, flexible approach to collaborative product design 
specifically developed by systems engineers for systems engineers. Supported by an experienced staff of 
engineering professionals with real-world knowledge of the latest approaches and proven project 
experience, GENESYS puts project success first. 

Unlike software tools focused on document-centric or diagram-centric approaches, GENESYS delivers a 
truly collaborative design-centric approach to product development. GENESYS provides comprehensive 
traceability from need definition through requirements and analysis to architecture and test. Built upon a 
proven approach and a central integrated design repository, GENESYS includes a comprehensive behavior 
modeling notation to better understand the dynamics of your design, integrated product simulation derived 
directly from your models, and on-demand automatic document and view generation. With numerous views 
tailored to the multitude of engineering and management tasks, GENESYS enables your team to focus on 
the creative aspects of engineering and system architecting. 

This guided tour can be used in conjunction with GENESYS Pro. Modifications for GENESYS users are 
provided. Some additional information about this guided tour: 

• This guided tour provides a simple, structured walkthrough of a sample product engineering 
problem to introduce users to the basic concepts and capabilities of GENESYS. It is not intended 
to demonstrate the full power and flexibility of GENESYS. 

• All versions include the sample database, the Geospatial Library, as it has been captured in the 
tool. The sample solution is presented in the data file at C:\Program Files\Vitech\GENESYS 
2024\Samples\Project Samples that installed with your GENESYS software. You can use this 
guided tour to recreate a portion of the solution from scratch as we go along (starting on page 27). 

• Help documentation and the GENESYS System Definition Guide that are installed with GENESYS 
provide in-depth information beyond what is contained in this tour. 

• Moving far beyond this introduction, Vitech offers several informational and training opportunities 
ranging from a one-day seminar on model-based systems engineering (MBSE) to a four-day course 
for practitioners. Whether you are interested in an MBSE overview or a hands-on class in 
GENESYS, Vitech offers a course to meet your needs. Please contact Vitech or visit our website 
(https://www.vitechcorp.com/training-courses/) for more information on our training classes. 

Installing GENESYS 
If you haven’t yet installed the GENESYS software, please download the appropriate installation guide from 
our website at https://www.vitechcorp.com/software-documentation/. The installation guide walks you 
through installing, activating the software, and starting the software.  

NOTE: GENESYS 2024 supports 64-bit machines and can no longer be installed on 32-bit machines. The 
application files will now be installed in the 64-bit Program Files directory instead of the previous Program 
Files (x86) directory.  

https://www.vitechcorp.com/training-courses/
https://www.vitechcorp.com/software-documentation/
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If you have any questions or concerns regarding installation, licensing, or training for your GENESYS 
product(s), please contact us: 

• For installation or general customer support: support@vitechcorp.com 
• For licensing: licensing@vitechcorp.com 
• For information on systems engineering and GENESYS training, visit our website at:  

www.vitechcorp.com  
or contact your Account Executive 

+1 540.951.3322 
info@vitechcorp.com 

Overview of the GENESYS Product Family 
The GENESYS software suite brings the proven STRATA™ methodology together with an enterprise-ready 
architecture, giving you the ability to deliver MBSE seamlessly and consistently across your project team. 
GENESYS is an open architecture tool based on familiar standards, so you can focus on design instead of 
trying to get disparate tools to work together. GENESYS takes the guesswork out of implementation and 
delivers context-driven modeling for complex systems engineering problems.  

GENESYS 
GENESYS provides individuals, small teams, and distributed users a complete MBSE development solution 
ready for immediate use against a locally installed and maintained repository – yet also adds the ability to 
connect to a collaborative design environment, as required. Enjoy a robust product that includes a rich 
requirements management capability, multiple modeling notations in traditional or SysML view sets, 
integrated discrete-event simulation, comprehensive architecture analysis, verification and validation, and 
robust, on-demand documentation. 

GENESYS Pro 
Incorporating all the features found in GENESYS, GENESYS Pro delivers comprehensive support for 
DoDAF 2.0, including the full complement of available views and reports, providing a single vehicle that 
enables team-wide perspective and analysis and the industry-exclusive ability to deliver answers and 
insight in multiple formats, regardless of the input approach. Whether working independently or as part of 
the collaborative enterprise team, GENESYS Pro provides the ultimate answer in capability and flexibility. 

GENESYS Server 
Part of a large, complex, or data-rich effort? GENESYS Server functions as a remote repository and enables 
GENESYS and GENESYS Pro users the ability to operate offline and independently or as part of the 
collaborative engineering team operating together in one concurrent database. GENESYS Server provides 
a secure, convenient gateway for the team to operate in unison, taking advantage of the team-wide 
consolidation of information. 

As the engineering team centerpiece, GENESYS Server offers unparalleled ease of use, team-wide 
system-level insight, live access to the latest system changes, comprehensive analysis, and instant, 
thorough documentation. 

Key Concepts 

Integrated System Design Repository 
GENESYS’s integrated system design repository supports the many individuals who are adding, deleting, 
changing, and reviewing design information that results in the specification of a system. This centralization 
allows all team members to work from a common, controllable baseline. Additionally, this approach is key 
to providing consistency of the entities in the system design and assures that all design views (graphic and 
otherwise) are always synchronized and consistent. 

mailto:support@vitechcorp.com
mailto:licensing@vitechcorp.com
https://www.vitechcorp.com/
mailto:info@vitechcorp.com
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Comprehensive Systems Design Language™ (CSDL™) 
Our approach to attaining an explicit system specification is grounded in the use of the Comprehensive 
Systems Design Language (CSDL) provided with GENESYS. CSDL is a formal, structured language which 
avoids the ambiguity inherent in using common English to define or specify a system. The precise meaning 
of each language concept is fixed and documented to enhance team communication and assure 
unambiguous interpretation of specifications using this language. The data model repository is structured 
by the CSDL, which is being extended by the use, if needed. CSDL is an Entity-Relationship-Attribute (ERA) 
language augmented by graphical structures with semantic meaning. The CSDL is based on the following 
primitive language concepts: 

• Entities correspond to nouns in English. Entities define objects and serve as the basic units in the 
system repository. GENESYS groups these entities into one of several classes (e.g., Component, 
Function, etc.) in the system repository. 

• Relations are similar to verbs. To be precise, a relation that defines a link between two entities 
corresponds to the mathematical definition of a binary relation. Relations are not commutative; 
each relationship has a definite subject and object. However, for each relationship, there is a 
complementary relationship that defines the link from the object to the subject. For example, when 
you allocate a Function entity to a Component entity (using the allocated to relation), GENESYS 
automatically creates the performs relation linking the entities in the reverse direction.  

• Attributes further describe entities much like adjectives modify nouns. The attributes of an entity 
serve to define critical properties of entities. For instance, attributes of a Component would include 
the component Number and component Type. 

• Attributed-Relationships (i.e., attributes on relationships) correspond to adverbs in English. The 
attributes of a relationship serve to define critical properties of the relationship. For instance, 
attributes of a consumes relationship would include the quantity being consumed. 

• Structures provide specification of semantically explicit system control constructs (Concurrency, 
Iteration, Loop, Multiple Exit, Replication, Selection, and Sequence). Using this explicit notation, 
the behavior of the system can be validated and shown to be executable using a discrete event 
simulator. The simulator dynamically interprets a behavior representation, so the simulation is 
always synchronized with the current model contained in the system design repository. 

The data repository consists of entities that are modified by attributes and related to other entities. This 
structure corresponds to the object-oriented approach. Entities are represented as objects with the 
attributes stored as data within the objects. The relations then define the interaction between objects. 

In GENESYS, the CSDL is referred to as a schema (or the project metadata). The diagram below illustrates 
a subset of the basic schema, showing some of the primary systems engineering classes and relationships 
between them. 
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Figure 1 Primary Systems Engineering Entities 

Dynamic Graphical View Generators 
GENESYS dynamically generates diagrams directly from the system design repository ensuring that they 
are consistent with current design details. A change made in any view changes the design information in 
the database repository and, conversely, a change made to the database repository is automatically 
reflected in the graphical views. 

GENESYS delivers a mixture of traditional systems engineering and SysML representations enabling you 
to satisfy the specific needs of your project. GENESYS provides many different graphical views (listed 
below) to meet the interests of both engineering and management personnel. This feature allows the 
system design to be viewed in as many perspectives and layers of abstraction as necessary to understand 
the model: 

• Hierarchy and Spider Diagrams: graphically display several layers of relationships between entities 
on a single diagram such as functional, physical, and traceability hierarchy views. 

• Package Diagrams: display arbitrary clustering of model entities to communicate groupings and 
interrelationships of interest. 

• Requirements Diagrams: show system requirements and their relationships to logical and physical 
components of the solution. 

• Use Case Diagrams: describe the functionality of a system in terms of how its users interact with 
the system to achieve their goals.  

• Functional Flow Block Diagrams (FFBD): show functional flow, including control logic. 
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• Activity Diagrams and Enhanced Functional Flow Block Diagrams (EFFBD): portray behavioral 
flow, control logic, and inputs/outputs/triggers. 

• Sequence Diagrams: represent interactions between functions and their corresponding components. 
• Integration Definition for Function Modeling (IDEF0) Diagrams: show functions, inputs, outputs, 

controls, and mechanisms.  
• N2 (N-squared) Diagrams: display functions/components and their internal and external 

interactions in a matrix format. 
• Block Definition Diagrams: show composition and classification of the physical architecture. 
• Physical Block Diagrams, Interface Block Diagrams, and Internal Block Diagrams: show 

composition and connectivity (both physical and logical) of the physical architecture. 
• State Transition Diagram: shows the logical transition of a system through various states of 

operation. 
• Parametric Constraint Diagram: used to create systems of equations that can constrain the 

properties of blocks. 
• Class Diagram: UML diagram used to describe the structure of a system by showing the system’s 

classes, their attributes, operations (methods), and the relationships among objects.  

As you design diagrams, GENESYS’ built-in features refine the layout to automatically space and align 
items on the diagram, prevent overlapping of nodes when applying layouts, and anchor diagram items to 
prevent them from inadvertently moving.  

GENESYS makes it easy to manipulate diagrams and move items around on the diagram. There are also 
easily accessible commands on the Diagram ribbon that you can use to enhance your diagrams like the 
Distribute Lines command that evenly distributes node connections.  

GENESYS users can undo and redo actions on all diagrams, saving a lot of time fixing diagrams.  

Any action that changes the state of the diagram can be undone and redone. This includes layout changes 
like changing colors and sizes of nodes and moving items on the diagram. It also includes database 
transactions like creating and deleting entities, relationships, and attributes on the diagrams. 

Eliding (Hiding) Diagram Content 
The Presentation Mode command, accessed on the Diagram ribbon, enables GENESYS users to elide 
(hide) various content in diagrams in various contexts. Elision is a SysML concept that enables both delivery 
of comprehensive, complete, correct representations from underlying models and enables customers to 
focus on areas of interest by hiding content. 

1. To mark an item on a diagram for elision, select it and click the Hide  icon  
on the Diagram ribbon, or right-click the item and select Hide on the  
drop-down list that appears.  

NOTE: To mark several diagram items for elision at once, hold the SHIFT key down while selecting 
items.  

Any selectable object in the diagram can be elided, including nodes, lines, and overlay objects like 
images, notes, and shapes.  

NOTE: Dependent content that would not appear on the diagram if the object it is dependent on 
were not present will also be hidden. 

The diagram display mode determines if the elided content will be displayed on the diagram. 
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2. Select the display mode by clicking the Presentation Mode  icon on the Diagram 
ribbon and then selecting one of the four display mode options (Standard, Marked, Hidden (with 
label), Hidden) from the drop-down menu that displays.  

 

The four display modes are shown below in the Activity Diagram. 

Standard Display Mode 
Standard display mode is the default mode for all diagrams. In Standard display mode, all diagram content 
displays, including items marked as elided.  
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Marked Display Mode 
In Marked display mode, all diagram content that is marked as elided, and all dependent content, is 
displayed with dashed borders and italicized text.  
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Hidden (with Label) Display Mode 
Hidden (with label) display mode hides all diagram content marked as elided and all dependent content. 

A SysML-style frame block displays “elided” on the upper right corner of the diagram frame. For technical 
audiences, it may be important to clearly communicate that some content in the diagram has been hidden. 
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Hidden Display Mode 
Hidden display mode hides all diagram content marked as elided and all dependent content in the diagram.  

 

The display mode is saved as a setting for the diagram after a user selects a new display mode and then 
saves the diagram. The diagram will open the next time with the saved display mode.  

When viewing a diagram, users can switch back and forth between the display modes by selecting the 
options on the Elision drop-down menu.  

 

Automatic Document Generation 
The GENESYS report generator enables users to extract information from the GENESYS system design 
repository and present it in virtually any desired format. Reports allow users to view the system design 
information in diverse ways. Reports in GENESYS can range from a simple query (e.g., a list of all open 
concerns) to complex, formal documents (e.g., a System/Segment Specification). Reports and analyses for 
engineering or management support are generated through more than 50 standard queries and report 
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templates 1 provided with GENESYS. Reports in GENESYS can be generated in the following formats: 
PDF, HTML, MHT, RTF, XLS, XLSX, CSV, and TXT. 

The structure of a report is controlled by a report entity that instructs the report generator how to query the 
system design database repository to gather data and format the information for each portion of the report. 
Users can develop custom reports and queries. Reports are written using the report designer in GENESYS, 
and no scripting is necessary for basic reports. 

2. EXAMINING GENESYS 
This section provides more information on the GENESYS tool:  

• Launch GENESYS 
• Import a data file into GENESYS. 
• Look at basic GENESYS windows. 
• Save a data file from GENESYS. 

The Sample Problem: Geospatial Library 
In this section, we will use a sample database for the Geospatial Library to provide an overview of 
GENESYS and its features. The context diagram below provides a high-level view of the system we will 
use throughout this guided tour. You may find it helpful to refer to this diagram as you build the system 
structure while working through the guided tour. 

 

 

The Geospatial Library demonstrates the use of automated systems engineering support tools. As defined, 
this demonstration system accepts requests for imagery information, determines the best way for the 

 
1 A list of the full set of reports provided with GENESYS is shown on page 60.  

 

Figure 1 Geospatial Library (GL) Overview 
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system to respond to the request, and then provides the requested information to the requestor. In the 
process of acquiring the requested information, the system may generate tasking orders for a set of imagery 
data collectors. 

Guided Tour Conventions 
The following special styling is used throughout the guided tour to help you navigate. 

 

 

 

 

 

 

 

 

 

Getting Started with GENESYS 
This section will guide you in getting started with GENESYS. In this section, you will import a sample file, 
receive an overview of the basic menus and features, and save your work in progress. 

Once you have installed GENESYS, launch the application. 

1. Click the Windows Start button. 
2. Select All Programs, open the GENESYS 2024 folder, and click GENESYS 2024.  
3. The following window displays. Enter the default username “Administrator” and the default 

password “admin”, then click OK or press the Enter key. 

 

Font Style Description 

Function Classes 

Number Attributes 

allocated to Relationships 

Contact Emergency 
Response 

User selections and 
inputs 

File > Import… GENESYS commands, 
buttons, icons or tabs 
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When you have successfully logged into GENESYS, the home screen displays.  

 

When you open GENESYS, you are logged into a database containing zero, one, or more projects. A 
database (also known as a repository) can contain multiple projects with each project containing its own 
set of data (referred to as the system design repository). You can select an existing project or create a new 
project by either directly importing an existing project or by selecting New Project and entering a project 
name. 

Importing GENESYS Data 
To introduce you to GENESYS, we want to import a project, so we can see the GENESYS system design 
repository populated with data. We will use the Geospatial Library sample project which has already been 
created in GENESYS and then exported to the C:\Program Files\Vitech\GENESYS 2024\Samples\Project 
Samples directory. In general, this import/export capability of GENESYS allows you to transfer a GENESYS 
project from one computer to another or make a backup copy of the data. 

In Section 3, Starting a GENESYS Project, you will learn how to use GENESYS by building this sample 
project yourself. 

To import a GENESYS data file: 

1. In GENESYS, click the File Menu.  
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2. Select Import. This opens the Import GENESYS File dialog. 

 

3. Navigate to the C:\Program Files\Vitech\GENESYS 2024\Samples\Project Samples directory and 
select the file named Geospatial Library Sample.gnsx. 

4. Click Open. The Import Wizard will appear allowing you to control the import. 
5. In Step 1, since our GNSX file contains only one project, click Next. 
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6. In Step 2, since we want to create a new project rather than importing it into an existing project, 
click Next.  

 

7. In Step 3, to begin the import click Import.  
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The Job Monitor will show the progress of building the new project and importing the project data. 

 

NOTE: Upon completion of the import, the word “False” will appear to indicate there were no conflicts. 

8. When the import is complete, click Close to close the Job Monitor. 

We will now open the imported project. 
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9. Select SAMPLE: Geospatial Library in the Project list. 
10. Click Open. 

 

When the project opens, the Project Explorer pane that lists all of the items in the project displays on the 
left and the project properties display on the right. 

Later in this guide, the items in the Project Explorer pane will be defined. 
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The project properties include: 

 project name 
 description 
 guidance information 
 organization name and address 
 customer name and address 
 base path where the application is stored 
 external graphics path 
 completeness checker script (selected from a drop-down menu accessed by clicking the Browse icon) 
 design integrity checker script (selected from a drop-down menu accessed by clicking the Browse icon) 
 versioning enabled/disabled  
 audit logging turned on/off  
 baseline schema version 
 unique entity names true/false 
 version number 
 created by  
 modified by 
 ID 

If you select the Statistics tab on the bottom of the screen, project statistics are displayed, as shown below.  
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Project statistics include: 

 Number of entities in the project 
 Number of relationships in the project 
 Number of related projects 
 Number of cross-project entities 
 Number of cross-project relationships 
 Number of cross-project entity references (entity attributes) 
 Number of cross-project entity references (relationship attributes) 

These statistics provide valuable information and insight on the size of a project (number of entities, 
relationships, etc.) and the degree of interconnectivity (cross-project entities, relationships, etc.) with other 
projects. 
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11. Click on the Component class in the Project Explorer pane. 

 

The Main GENESYS Window 
The Project Explorer pane on the left lists the classes and folders in the system design repository. The main 
GENESYS window provides quick access to information contained in the system design repository for a 
particular project. Ribbons provide icons to access frequently used commands.  
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Browser 
Selecting one of the classes/folders in the Project Explorer pane displays all that folder’s entities in the 
Browser pane. In the Properties, you can view the structure of the data, create new entities, and update 
entities. A tan folder preceding the class name in the Project Explorer pane indicates that at least one entity 
(instance) of that class has been defined. The numbers in parentheses indicate how many entities have 
been defined for that folder and how many total entities are contained in that folder and all its subfolders. 
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1. With the folder Component selected in the Project Explorer pane, select the Component named 
Geospatial Library in the Browser pane. 

The property sheet for the Component will be populated. Notice that the bottom-right of the screen now 
displays a Views tab for the diagrams available for this class. 
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Model Assistant and Model Assistant Rules 
The Model Assistant is on by default which is causing GENESYS to automatically display view tabs for the 
logical and physical views.  

The Model Assistant is a convenient built-in tool in GENESYS that applies rules to the model to assist 
GENESYS users.  

Some useful rules it applies to use cases and states (that will be discussed later) are described below. 
These rules enable users to easily flow through related concepts and levels of abstraction by further 
connecting behavior to use cases and states.  

Use Case Rule Examples 
The Auto-Create Primary Function for Use Cases rule, when enabled, automatically creates a primary 
function whenever a GENESYS user creates a use case or use case subclass. It also automatically creates 
an elaborated by relationship between the use case and the primary function.  
 
The Show Primary Function Views for Use Cases rule, when enabled, directly opens logical and behavioral 
views for use cases and use case subclasses. 

State Rule Examples 
The Auto-Create Root Function for States rule, when enabled, creates a root function whenever a 
GENESYS user creates a state. It also automatically creates an incorporates relationship between the state 
and the root function. 
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The Show Root Function Views for States rule, when enabled, directly opens logical views for state and 
state subclasses.  
 
To learn more about the Model Assistant, reference the Model Assistant screencast found in the GENESYS 
Screencast Archive on our website at https://www.vitechcorp.com/genesys-screencasts-on-demand/. 

Entity Property Sheet 
A property sheet provides the complete definition of a given entity in the system design repository by 
displaying all the attribute values, the system properties, the parameters, and the relationships. You can 
use the property sheet view corresponding to any entity to view, add, or make changes to the attributes and 
relationships of the displayed entity. The list of attributes and relationships differs depending on the class 
of the entity displayed. Here, we are looking at an entity of the Component class, so only those attributes 
and relationships that pertain to Components are displayed. 

1. Open the property sheet as a separate window by double-clicking on the entity name –
Geospatial Library in this case – in the Browser pane or, with the entity selected, click on 
the Views tab in the ribbon, then the Properties icon.  

The attributes and their values are displayed in the upper portion of the sheet. The relationships and targets 
that complete the entity definition are displayed in the lower portion of the window. Use the scrollbars on 
the right to view the complete list of attributes and relationships. 

 

2. Scroll through the attributes. Attributes are shown on the Attributes tab. Additional detail can be 
found on the Properties tab, the Parameters tab, the Diagnostics tab, and the Views tab.  

https://www.vitechcorp.com/genesys-screencasts-on-demand/
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3. Scroll through the list of possible relationships. A folder in front of a relationship indicates that a 
target has been established for the relationship. The down arrow indicates that the relation is to 
children entities. The up arrow indicates that the relation is to parent entities.  

4. In the list of relationships, click on built from. The expand arrow in front of the target indicates that 
the relationship has an attribute. Use the expand arrow to collapse/expand the list. 

 

5. Close the property sheet. 

Accessing a Graphical View 
You can directly access the entity views by selecting the view tabs at the bottom of the property sheet, the 
Views ribbon icons, or the Open Entity command in the right-click menu of the Browser pane. Selecting 
the bottom view tabs opens the view within the main window. To create more room for a tabbed view, you 
can stack the Project Explorer and Browser panes by dragging one on top of the other. Clicking an icon on 
the Views ribbon opens the view in a separate window. 

NOTE: The steps below assume a GENESYS Pro license. If you have a GENESYS license and the specific 
view is not accessible, you can view a different diagram on a Component entity for this step. For future 
occurrences, you’ll see a note accompanied by information for GENESYS users. 

Let’s look at an example. A Block Definition Diagram (BDD) represents the composition structure of 
systems, Components, Items, conceptual entities, and logical abstractions. Part of the physical 
architecture representation set, this is like a traditional physical hierarchy with select semantic and 
representational differences. Most notably, the BDD can optionally indicate the role that the part plays 
regarding its parent. 

1. Select Geospatial Library from the list of entities in the Component class. 

2. In the view tabs along the bottom of the screen, click the BDD tab  to display the 
BDD of the entity (or click the equivalent icon in the ribbon to open the view in a separate window). 

NOTE: Throughout the guided tour, we will often open a separate view to enhance the readability of the 
view contents in this document. Where this occurs, you can display the view in the main window by clicking 
the corresponding view tab (in the case of hierarchy diagrams, you must also select the type of hierarchy 
from the drop-down menu). Once the view is displayed, the step-by-step instructions to modify the view will 
still apply. 

The Toolbox (on the right-hand side of the diagram) is available to manage the diagram. By selecting a 
Construct and dragging it to the desired position on the diagram, it can be added to the view.  

By selecting the Key Entities icon, classes and entities that can be added to the view are 
displayed. Using drag-drop will add the selected entity.  
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By selecting the All Entities icon, all classes and entities are available and can be related to any 
entity in the view using drag-drop. Any action using the Toolbox will also update the underlying 
data model. 

If you opened a separate window to view the BDD, please close it now. 

Saving GENESYS Data 

Saving Data in the Local or Server Repository 
Data in your local repository is saved in an instance of SQL Server Express on your local machine. Data is 
committed as you create it. No further save actions are required to commit your data. Vitech recommends 
following your organization’s backup procedures to further ensure the security of your data. 

Saving Data to a GENESYS Server 
GENESYS Server is built on the full version of SQL Server. Like saving data in your local repository, data 
is committed as you create it. Your organization’s backup procedures should be followed to further ensure 
the security of your data. 

Saving Data to GNSX 
GNSX is the GENESYS data format that is used for export/import, backup, and data exchange. This 
provides “single file” storage for all project data: multiple projects, schema, stored views, sort blocks, 
hierarchy definitions, filters, etc.  

To save your data to a GNSX file: 

1. Select the File Menu > Export. 

  

An Export Options dialog will open. 
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2. Click OK, since we will use the default settings to export the entire project. 

 

3. When the Save As dialog appears, name the export file Geospatial Library.gnsx and select the 
desired save location. 

4. Click Save. The Job Monitor indicates the progress of the export.  
5. Click Close in the Job Monitor when the export is complete. 
6. Close the Geospatial Library model by clicking on the File Menu and then clicking Close Project.  
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Importing a Package 
To import a package into GENESYS: 

1. Select File > Import.  

The Import Wizard appears.  

NOTE: A package has a .gnsx file extension. It is created by exporting a package/project from GENESYS.  

The GENESYS smart import feature detects the type of file/package being imported and displays the 
appropriate import options for that file/package.  

2. For a package, at the Scenario drop-down list that appears at the top of the Import Wizard, select 
the import method (Load Package or Instantiate Model Segment). 
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To assist the GENESYS user in selecting the appropriate import method, a description of the option appears 
on the window when they select one of the options.  
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The Load Package option imports all package content without modifying the entity IDs or names. This 
method supports model management through packages. 
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The Instantiate Model Segment option imports all package content and modifies the entity IDs. This method 
supports instantiating a pattern, part, or other model segment for use in a GENESYS project. It is highly 
recommended that users specify an entity name prefix or suffix to differentiate entities instantiated as part 
of this model segment. 

Load Package is the default method. 

3. After selecting the import method, click Next. 
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4. Select Create New Project or Import into Project and click Next. 
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The third wizard screen displays the selected options for import. 

5. Click Import to begin importing the package. 

The Job Monitor window displays. 
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The third column on the Job Monitor indicates Finished if the import has completed. 

The fifth column on the Job Monitor states True or False to indicate if any conflicts occurred during the 
import process. 

3. STARTING A GENESYS PROJECT 
This section covers the beginning steps in working with requirements: 

• Introduce the Guided Tour’s user exercise 
• Extract requirements into GENESYS 
• View the requirement hierarchy 
• Use the diagram toolbox 

The Sample Problem: Geospatial Library 
In the rest of the guided tour, you will use GENESYS and several of its features by systematically building 
the sample design for the Geospatial Library. Please review the Geospatial Library context diagram and its 
description as found in Section The Sample Problem: Geospatial Library. You may find it helpful to refer to 
this diagram as you build the system structure. 

Summary of the Typical Top-down Process 
GENESYS supports top-down, bottom-up (reverse), and middle-out engineering processes / paradigms. 
For this guided tour, we are using a top-down approach assuming the Geospatial Library is an 
unprecedented system. We will begin by extracting our source requirements using the GENESYS 
Document Parser. We will then analyze and refine our source requirements. After analyzing the 
requirements, we will define our system boundary and capture the physical architecture constraints. Finally, 
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we will derive the system behavior and extend the physical architecture, allowing us to allocate the behavior 
to the appropriate system components.  

The CSDL characterizes the stakeholder and system requirements in the system design repository by 
capturing each requirement’s relationships and attributes. The developing system design model is 
concurrently analyzed by the design team for “fitness” as a solution, identifying any inherent design 
impediments, while checking the model for consistency and completeness. While the functional behavior 
definition is proceeding, the physical decomposition of the system is specified so that the behavior can be 
allocated to the physical system components responsible for performing the functions. One result of this 
allocation is the definition of all interfaces between the physical entities of the system, including hardware, 
software, and people. We will complete the following steps in this guided tour: 

1. Capture the source document, often a starting point for top-down engineering. 
2. Capture the requirements from the source documentation. 
3. Define the system and its boundary. 
4. Derive the system behavior while extending the physical architecture and allocating all behavior to 

the physical architecture. 

After completing this, we will have established traceability among the relevant design entities, identified and 
resolved critical concerns, and provided documentation. 

Capturing the Problem and Source Requirements 
In Section 2, we learned how to import and view an established project file. Now we will begin building our 
model in GENESYS, starting with an empty project.  

To create a new project:  

• Click the File Menu and select New Project., or click New Project on the GENESYS Home page 
or in Administrative Tools under the Projects tab. 

• Name your project My Guided Tour Work. 
• Accept all other default settings and click OK. 

 

Your project will be created and will automatically open when project creation is complete. With the project 
open you can fill in basic information like names (Organization/Customer) and addresses. 
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Loading the Source Document 
We will start by using the Document Parser to capture the relevant information from the source document 
and import it into your new GENESYS project. To do this: 

1. Under the Utilities ribbon, click the Document Parser icon. 
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Once the Document Parser opens, we will browse for the source document. 

The source document must be a DOCX, DOC, HTM, HTML, RTF, or TXT file. To load your source 
document: 

Click on the Load Document icon on the ribbon.  

We will use the file GeospatialLibrarySourceDocument.doc, located in the GENESYS 
2024\Samples\Project Samples folder. 

2. Navigate to the \Program Files\Vitech\GENESYS 2024\Samples\Project Samples folder. 
3. Select GeospatialLibrarySourceDocument.doc. 
4. Click Open. 
5. Next identify the source document that will be parsed by clicking Select in the bottom-right of the 

Document Parser. 
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Since this is a new project, there are currently no document entities in our model. We will create a document 
entity to represent our source document (this will later provide traceability from the source document to the 
imported requirements). To do this: 

6. On the Document line, click the Select button. 
7. Select New to enter a new document.  
8. Enter GL Source Document then click OK. 
9. Click OK one more time to close the dialog. 

We can enter a prefix that can be used for all the entities created. We are not going to do so for this example. 

We will identify the keywords that will be used in parsing the document. The Keywords field is auto 
populated by default with the most common keywords used to indicate a Requirement. Additional keywords 
may be added or deleted by the user. 

Finally, we can let the parser auto-name the entities using the words following the first keyword found.  

Parsing the Document 
The GeospatialLibrarySourceDocument.docx file displays in the center pane of the Document Parser.  
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The Document Parser can extract text into any class of entities. The Requirement class is pre-selected, 
as it is the most common destination class for parsed data. 

If you wish to further organize your data, you can add a sub-folder under the Requirement class, and then 
add your requirements to the sub-folder as needed. In this instance, we will leave the folder structure as is. 

Select the Parse Document icon located on the ribbon. 

The Parser will parse the entire document’s statements (or sentences) into the project. Statements that 
contain one of the keywords are named with the word “Requirements” and a number. Others are loosely 
termed “debris” and may include boilerplate text or other valuable content, which we will assess later. Where 
possible, the parser identifies attributes and creates the refines relationship for an entity when a hierarchy 
is identified. 

10. Close the Document Parser. 

Identifying Other Entities 
Our next step is to identify other useful statements that were imported with the Requirements and transform 
them to the appropriate class. 

11. In the Project Explorer pane, select the Requirement class. 

 

The Document Parser imported the entities into the Requirement class. 
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One of the requirements contains a description of the Geospatial Library and would better serve as a basic 
entity for constructing a Component entity representing our System of Interest. 

To transform an entity from one class to another: 

1. Select the requirement that you want to transform.  
2. Click on the Data ribbon. 
3. Select Transform Class command. 
4. Select the Component class from the drop-down options. 
5. The following dialog will appear. Select OK to confirm. 

 

6. Click on the Component class in the Project Explorer pane. 
7. Select the entity that you are transforming.  

The property sheet of that entity will display. Let’s complete the definition of this entity. 

8. Click in the Name field and replace the current text with Geospatial Library. 
9. Set the Type attribute to System using the drop-down selection list. 

There is another entity in the Requirement class that contains information to help us further define our 
Geospatial Library component. 

10. Switch back to the Requirement class and select that entity. 
11. Highlight the text in the Description field, right-click and select Copy. 
12. Switch back to the Component class and select the Geospatial Library entity. 
13. Right-click in the Mission field and select Paste. (On some monitors, you may need to scroll down 

in the property sheet to locate the Mission attribute.) 

Defining a Relationship 
For a complete model, we must establish relationships between various entities to ensure full system and 
lifecycle traceability. The Document Parser automatically established a Requirement hierarchy by creating 
the refines relationships between the Requirements imported from the Source Document. The Document 
Parser also created the documented by relationship between the top-level Requirements and the GL 
Source Document entity.  

The following step will establish a documented by relationship between the Component Geospatial Library 
and the GL Source Document entity. 
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1. Double-click the documented by relation in the Relationships pane (or select the relationship and 
select Edit Targets from the right-click menu) to open an Edit Targets dialog for the relationship. 

 

The Edit Targets dialog is used to add one or more targets to the selected relationship (or to remove targets 
from the selected relationship). 

2. Select the Document class. 
3. Select the GL Source Document entity in the Possible Targets pane. 
4. Click Add, then Close. 

The remaining Requirements should be reviewed to see what other useful information has been captured.  

The Document Parser created a numbering scheme from the paragraph numbers contained in the Source 
Document. Although it named our requirements entities, we need to fix these names to be meaningful when 
viewed in a list.  

5. Select the Requirement class. 
6. Select entity 4.1 Accept Information Requests From Certified. 
7. Click in the Name field. 
8. Replace the current text with Accept Requests. 
9. Repeat this process to rename all the requirements as outlined in the following table. 

 

Number Name 

4.0 Specific Requirements  

4.1 Accept Requests 

4.2 Retain Inventory and Provide Products 

4.3 Control Multiple Collectors and Collector 
Types 

4.4 Maximum Staff 
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4.5 Provide Feedback 

4.6 Prioritize Requests 

4.7 Monitor and Assess Performance 

Notice the General Requirements at the bottom of your Requirements list. For consistency, we need to 
rename and renumber two of these requirements. 

10. Rename Requirement 3.1 Provide Continuous Real-time Support to Continuous Support. 
11. Rename 3.2 Be Unavailable No More Than to Availability. 

This concludes the review of the entities created by the Document Parser. We can now delete the unused 
entities using the following method: 

12. Using the CTRL + Click method, multi-select all the remaining requirements (from the top of the 
list), Scope, and Applicable Documents. 
 

13. Click the Delete icon in the ribbon. 

 

14. Click Yes when prompted to confirm the deletion. 

The following shows the resulting list of requirements in the Browser pane. 

 

Extracting the Child-Level Originating Requirements 
Many of the captured Requirements are compound statements. Because an effective requirement should 
only contain one “shall” statement, we will break out the compound statements into child-level functional 
Requirements. Each child Requirement will relate to its parent requirement using the refines relationship. 
Traceability back to the source document, GL Source Document, is achieved through the parent 
requirement (as defined with the documented by relationship).  

In GENESYS, the Duplicate command will allow you to create a copy of an entity, causing the new entity 
to inherit the attributes of the original entity, which is particularly useful when creating child-level 
requirements. 

1. Select 4.2 Retain Inventory and Provide Products. 
2. Right-click on the entity and click Duplicate. 
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The dialog shown above offers a check box to use if you wish to copy the entity with relationships. In this 
case, we do not. 

3. Click Ok without checking the box. (This will duplicate the entity without the relationships.) 

The property sheet of the new entity is created. The new entity is named Retain Inventory and Provide 
Products - Copy. To further define the new Requirement: 

4. Edit the Name field to read Retain Inventory. 
5. Set the Number attribute to 4.2.1. 
6. Set the Type attribute to Functional. 
7. Create a refines relationship with 4.2 Retain Inventory and Provide Products as the target. 

Requirement 4.2 has two statements, and at this stage, we’ve broken out one of them. We need to repeat 
the process to complete the decomposition. 

8. Duplicate requirement 4.2 Retain Inventory and Provide Products.  
9. Edit the Name field to read Provide Products. 
10. Set the Number attribute to 4.2.2. 
11. Set the Type attribute to Functional. 
12. Create a refines relationship with 4.2 Retain Inventory and Provide Products as the target. 

Since there are many compound requirements imported from our GL Source Document, you should 
examine all the requirements for compound statements and decompose them into leaf-level requirements. 
For the sake of brevity of this tutorial, we will skip this step, but if time permits, you are encouraged to 
decompose these requirements for good engineering practice. 

Viewing a Traceability Spider or Hierarchy Diagram 
Let’s look at a Traceability view of our Source Document. If we select the GL Source document, we can 
show traceability from our source document down through the Requirements, using either the hierarchy 
or spider diagram. As our model progresses, the diagram can be expanded to show traceability through the 
entire design. 

1. In the Project Explorer pane, select the Document class. 
2. Select the GL Source Document entity to show the property sheet. 
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3. Select the Views tab on the ribbon. 

 

NOTE: The following steps can be done in one of two diagrams.  

4. Click on either the Spider Diagram icon or the Hierarchy Diagram icon from the ribbon to open a 
hierarchy definition dialog. 

The hierarchy definition editor provides selections for building various hierarchy diagrams. You can click 
the drop-down arrow to see the default set of hierarchy diagrams available. We will use Traceability, which 
was selected by default. 

5. Click OK. 

 

NOTE: A single icon with a black dot in the upper-left corner can be expanded individually. Select the icon, 
and then right-click to view a menu. Select Expand Nodes and set the number of levels you wish to expand 
below the highlighted icon; the default is one.  



Systems Engineering Guided Tour 

44 

Adding Entities in a Traceability Spider Diagram 
GENESYS allows us to create entities and relationships directly in a 
diagram. Using the spider diagram, we will create a relationship between 
the Continuous Support requirement and our System of Interest 
(Geospatial Library component) using the specifies relation. 

NOTE: The following steps can be done in either the Spider diagram or the 
Hierarchy diagram. If you previously opened a Hierarchy diagram, close 
that window, then click on the Spider Diagram icon selecting the 
Traceability view. 

1. From the spider diagram’s Toolbox (found on the right 
side of the view,) select the All Entities icon, then click 
on the Component class, then the entity Geospatial 
Library. 

2. Drag Geospatial Library on top of Continuous Support on the 
diagram, dropping it there to display the available relations. 

3. Click specified by. 

Notice in the diagram below that new relationships have been added. 
These relationships will also be reflected in the underlying data model. 
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Replacing Icons with Graphics 
GENESYS has a library of graphics that can be used to enhance the visualization of your diagrams. Let’s 
change the Geospatial Library component entity to display an image in place of the traditional icon. 

1. Select the Geospatial Library entity on the diagram. 
2. In the Toolbox, click the Properties tab. 
3. Add a checkmark next to Show Image. 
4. Adjust the size of the image. 

 

5. Close the Spider Diagram. 

Capturing Requirements Concerns 
Now that we have extracted the source Requirements, analysis begins. As a systems engineer, you want 
to identify problems discovered during your Requirement analysis to address and manage issues such as 
poorly written or conflicting requirements. In GENESYS, these problems can be captured as Concerns. A 
Concern is an entity in the design repository that identifies a problem (as well as its resolution). The primary 
application for the Concern class is documenting problems with Requirements, but it may be used in 
conjunction with any class/entity in the repository. 
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In our set of source Requirements, we can see that our system must accept requests from the customers. 
However, the format of the requests is not identified.  

Let’s capture that Concern. 

Look at the Project Explorer pane. Did you notice that Concern is not listed in our list of classes? 

GENESYS has defined five Facilities listed in the Project Explore pane. A Facility is a group of classes 
chosen for an area of interest. By default, GENESYS opens to the GENESYS 2024 facility when the project 
is first opened. This contains the foundational root classes for systems engineering and doesn’t include the 
Concern class. 

Let’s switch to the Systems Engineering facility whose classes have been chosen because their entities 
are associated specifically with system design and specification. 

1. In the Project Explorer pane, click the drop-down arrow next to Essentials. 
2. Select Systems Engineering. 

Now, let’s get back to capturing our Concern. 

3. Select the Concern class. 
4. Double-click Concern to create a new entity. 
5. Name the entity Media of Request and press OK to close the dialog. 

 

We link a Concern to the entity that generated the problem via the generated by relation.  

6. Double-click generated by in the Relationships pane.  
7. Add the Requirement 4.1 Accept Requests to the Target list. 
8. Click Close. 
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GENESYS allows you to capture both the Concern and the decision that resolves the Concern. You can 
document your decision, your alternatives, and your rationale in the appropriate attributes. In this way, 
GENESYS serves as a repository for the project design history – capturing “the why” of systems engineering 
decisions. 

We will complete the Media of Request entity to capture the analysis of the problem.  

9. Type text in the Description and Alternatives fields. You can use the text as shown on the image 
below or develop your own. 
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4. DEFINING THE SYSTEM AND ITS BOUNDARY AND BUILDING THE 
BEHAVIOR MODEL 

This section will cover defining the system of interest, including the system boundary, allowing users to 
identify external interfaces for the system. 

• Create the system 
• Establish the system boundary 
• View the Physical Hierarchy Define the top-level behavior 
• Refine the behavior 
• Utilize various diagram views 
• Establish requirements traceability 

Defining the System Environment 
To define the system and its boundary in GENESYS, we must use the system context, identify the top-level 
Components (physical entities), their top-level (root) Functions, and any top-level inputs and outputs. We 
will determine the system boundary by defining our system of interest and the external systems in which 
we must interface. To begin, we need to define the overall outside of our system. 

A Component entity of Type System is used to identify the system and capture the system-level mission. 
A Component is an abstract term that represents the hardware, software, people, or grouping thereof that 
performs a specific function(s) for the system. 

The Model Assistant has created the high-level System Context Component entity, which represents the 
context of our system. 

1. From the Project Explorer pane, select the Component class and the new entity System Context. 
NOTE: The following steps use the BDD diagram. Similar actions can be performed in the physical block 
diagram.  

 
2. Select the BDD tab. 
3. From the Toolbox, click the Key Entities icon, then drag the Component Geospatial Library on 

top of System Context to create the built in relationship. 

By adding the Geospatial Library component to the BDD, we have established that our System of Interest 
is a part of our System Context. We will now add the necessary external systems to the System Context, 
helping us identify our top-level external interfaces. 

 

4. Click on the Constructs icon in the Toolbox. 

 

5. Drag the Parts construct and drop it onto the System Context entity.  
 

6. Select the Component class, then click New. 
7. Name the new entity Customers and click OK. 

This process creates the entity and establishes the built in relationship between the customers and our 
system context. 

8. Repeat, adding two more Components: Collectors, and Certification Authority, establishing built 
in relationships to the System Context entity.  
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9. Click Close to close the relationship dialog. 

Compare your diagram. NOTE: The diagram below utilizes the node template Name. Node templates can 
be set globally in Preferences on the Application Menu or via diagram using the Properties tab in the 
Toolbox. 

 

To create a well-defined model, we will now complete the definitions of the entities we just created, 
identifying the system of interest and the external systems contained in our system context diagram.  

10. Double-click on System Context to open its property sheet. 
11. Set the Number to C (identifying it as the context of our system). 
12. Type the following text in the Description field: The Context is the super-system that shows the 

physical relationship between the Geospatial Library and the external systems: Customers and 
Collectors. 

13. Set the Type to Context. 
14. Close the property sheet. 
15. Using the table below, repeat these steps to complete the entity definitions. Notice the Geospatial 

Library component will contain SYS as the prefix for the number. This is to indicate that it is the 
top-level component representing our system of interest. 

 

Number Name Description Type 

C.1 Customers The external system, customers, prepare requests for 
imagery products. 

Human 

C.2 Collectors The external system, collectors, is responsible for acquiring 
data to support the information that is requested but does 
not reside in the inventory. There are multiple collectors, of 
different types and capabilities. 

External 
System 

C.3 Certification 
Authority 

Provides the capability to verify a user's certification to 
use the Geospatial Library. 

External 
System 
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SYS.1 Geospatial 
Library 

This Geospatial Library demonstrates the use of automated 
systems engineering support tools. As defined, this 
demonstration system accepts requests for imagery 
information, determines the best way for the system to 
respond to the request, and then provides the requested 
information to the requestor. In the process of acquiring the 
requested information, the system may generate task 
orders for a set of imagery data collectors. 

System 

Creating Function Entities 
When the sample project was created, the Model Assistant was enabled. The Auto-create Root Function 
option allows GENESYS to automatically create a new Function entity whenever a new Component is 
created. The Model Assistant then relates the Function and Component with the performs/allocated to 
relation and sets the function’s behaviorType attribute to Integrated (Root) to identify that this is the top-
level Function which represents the totality of functionality performed by the system. This would later be 
decomposed into all the functions performed by the system. The creation of a Function for each 
Component and the traceability between the two is important for consistency within your model since each 
Component must perform at least one Function for our system. GENESYS names the new Function 
_Perform ABC Functions, where ABC is the name of the originating Component. 

Let’s view the existing Functions in our model and assign a number to each of them. 

1. Select the Function class in the Project Pane. 
2. Select the _Perform Geospatial Library Functions. 
3. Set the Number to 0. 
4. Set the remaining numbers using the following table: 

 

Number Name 

C _Perform System Context Functions 

C.1 _Perform Customers Functions 

C.2 _Perform Certification Authority Functions 

C.3 _Perform Collectors Functions 

We could build our functional model graphically by building either an activity diagram or an enhanced 
functional flow block diagram (EFFBD) of our context function, _Perform System Context Functions. For 
this example, we will use the activity diagram to show the behavior at the context level. The GENESYS 
activity diagrams and EFFBDs have the classic features of logic structures and functional decomposition. 
The logic constructs allow you to indicate the control structure and sequencing relationships of Functions. 

NOTE: The following steps use the Activity diagram. Similar actions can be performed in the EFFBD.  

5. In the Browser pane, select the Function entity _Perform System Context Functions. 
6. Click the Activity Diagram tab to open an activity diagram of the selected entity. 

NOTE: The default orientation for an Activity diagram is vertical (top to bottom). For our example, we have 
changed the orientation to horizontal (left to right). You can do this from the ribbon by clicking on the Layout 

 command and selecting Horizontal. 
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By default, dashed lines show control flow in Activity diagrams. To change to solid lines, reset the setting 
in the diagram Toolbox Properties or in Project Preferences. 

1. Access the Toolbox Properties, by selecting the Toolbox  icon on the Diagram ribbon and 
selecting the Properties tab in the Toolbox.  

2.  Uncheck the box next to Show Control Flow with Dashed Lines. 

 

1. Access Project Preferences by selecting the File menu and then the Preferences button located 
on the bottom right side of the File menu. Then select Preferences > Project Preferences > 
Diagrams > Activity.  

2. Uncheck the box next to Show Control Flow with Dashed Lines.  
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Relationships to Lower-Level Decomposed Items and Higher-Level Ancestors  

Relationships to lower-level decomposed items or higher-level ancestors are represented on diagrams by 
connecting them to internal items on diagrams rather than to external entities. Diagrams show these 
relationships as connections to diagram-level descendants or ancestors. 

This representation applies to all block diagram types (Physical, Interface, Internal, and Flow Internal) and 
the Sequence diagram.  

The connections to an internal source will be represented on the diagram by a filled half circle with the 
same fill color as the node, at the connection point on the node, as shown below. 
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In the diagram below, the Physical Environment entity connects to the Geospatial Library entity with a filled 
half circle showing that the connection is to a descendant or ancestor entity.  

 
The connection point can be moved anywhere around the surface of the node.  

Easily Identifying Parent-Child Relationships in Models with Up and Down Arrows 

GENESYS easily identifies Parent-Child relationships in models with Up and Down arrows. An Up arrow 
identifies a Child-Parent relationship, and a Down arrow identifies a Parent-Child relationship.  

When creating these relationships in the Project Browser pane, the Child-Parent and Parent-Child 
relationships have Up and Down arrows next to them, respectively.  

To create a Child-Parent relationship: 

1. Left click on the potential Child entity and drag-drop it onto the potential Parent entity.  
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2. Select “ built in” for the child relationship on the drop-down menu that appears, as shown below: 
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The new relationship appears in the Targets & Attributes pane on the bottom left side of the window. If the 
Parent entity is highlighted in the Browser pane, “built from Component Child” displays in the Targets & 
Attributes pane, as shown below. 

 



Systems Engineering Guided Tour 

57 

If the Child entity is highlighted in the Browser pane, “built in Component Parent” displays in the Targets & 
Attributes pane, shown below.  

 

NOTE: GENESYS enables you to create child-parent relationships with any of the classes. For instance, if 
you make a function a child of a parent function, it is represented by the decomposes/decomposed by 
relationship.  
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The new Child-Parent relationship is shown on the Hierarchy diagram, shown below. 
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The BDD also shows the new relationship.  
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Adding Inheritance to Save Time Constructing Models 
Adding inheritance to a model can save GENESYS users time constructing models. Entities can inherit 
attribute, property, and parameter values from other entities.  

The entity that another entity inherits values from is called the Generalization entity and is a target of the 
generalization of relationship in GENESYS.  

The entity that inherits the values is called the Specialization entity and is a target of the kind of relationship 
in GENESYS.  

In the example below, Collectors is the Generalization entity and Satellite and Unmanned Aerial Vehicle 
are the Specialization entities that inherit from Collectors. The arrows with the triangle heads pointing 
upward indicate that the Specialization entities inherit from the Generalization entity.  

 

The Specialization entity inherits all attribute values from the Generalization entity by default. 

The Inheritance icon at the right of the fields on the Attributes, Properties, and Parameters tabs of 
the Satellite and Unmanned Aerial Vehicle property sheets show which fields are inherited. The icon 
appears only for Specialization entities.  

Inherited fields are read-only and can only be changed in the Generalization entity.  
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Turning Inheritance On/Off to Inherit or Override Values 

Clicking on the Inheritance  icon for a field toggles the inheritance on/off for that field. A red x appears 

on the icon  indicating that the field is no longer inherited and that the value can be overridden. Users 
can override the value locally by entering a new value. 

 

Inheriting Property Values 
The Specialization entity also inherits text color, line color, node fill color, and image property values by 
default. 
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In the example below, after changing the node fill color of the Collectors entity to light blue, the Satellite 
and Unmanned Aerial Vehicle entities inherit this value and automatically display in light blue in the diagram.  
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Inheriting Parameter Fields 
The Specialization entity also inherits all the parameter fields by default. Parameters that are inherited 
display dimmed on the Parameters tab like the inherited Minimum field in the image below. 

 

Toggling the Inheritance icon at the right of the field activates the field. The field becomes undimmed 
and the inherited value can now be overwritten.  

Unlike attributes and properties, parameter fields can only be inherited/overwritten together as a group, not 
individually. 

Inheritance can also occur across projects.  
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Inserting a Parallel Structure 
Recall we have four Functions that we want to include in our System Context behavior diagram: _Perform 
Geospatial Library Functions, _Perform Customers Functions, _Perform Certification Authority Functions, 
and _Perform Collectors Functions. 

Each of these Functions performs in parallel. To incorporate these Functions and to show that they will 
execute concurrently, we will add parallel branches to our timeline and insert each function onto its own 
branch.  

 

1. From the Toolbox, click on the Parallel icon and drag-drop on top of the main 
branch. 

 

 

2. To add more branches, select the Branch icon and drag-drop it on top of either end 
of the Parallel construct. 

3. Repeat the drag-drop of the Branch icon so that you have four branches as shown below. 
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Adding Functions to an Activity Diagram 
Now, using drag-drop, we’ll insert one Function on 
each branch of the diagram.  

 

The Key Entities tab shows the entities that can be 
inserted onto the activity diagram. You can select 
from existing entities or create new ones. In this 
example, we will select from context level functions, 
which were automatically created by the Model 
Assistant earlier in the exercise. 

 

1. From the Toolbox, click the 
Key Entities icon.  

2. Select the Function class. 
3. Drag _Perform Customers Functions onto 

the top branch. 
4. Repeat this step to add _Perform 

Certification Authority Functions on the 
second branch, _Perform Geospatial Library 
Functions on the third branch, and _Perform 
Collectors Functions on the fourth (bottom) 
branch. branches and branch functions in 
behavior diagrams  
 
 

Adding Inputs and Outputs 
We now need to add the inputs and outputs that occur between each of our root functions to show the 
interdependencies of the Functions. While we are performing this example using the activity diagram, the 
process can also be accomplished using the EFFBD and N2 diagrams. 

Input and outputs are represented in GENESYS as Items. Items may be connected as either inputs or 
triggers. In a trigger-type connection, the receiving function will not execute until the trigger Item has 
‘arrived.’ With input type connections, the Function will be executed independent of the Item’s ‘arrival.’ In 
this example, each of the Items will be a trigger, since we would only include required interfaces and I/Os 
that will be exchanged between our system of interest and the required external systems on this diagram. 

1. In the Activity diagram, select _Perform Customers Functions. 
2. Hold the Shift key down and select _Perform Geospatial Library Functions. 
3. Click the Connect via Trigger icon on the Diagram ribbon to open a Connection 

Dialog. 
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4. Double-click on the Item folder to create a new entity. 
5. Name the new entity Requests and click OK. 
6. Click Close. 

NOTE: When using the Shift-Click method to select entities to connect, be intentional about the order in 
which you click-select them. The first entity selected will be the sending Function. The second entity 
selected will be the receiving Function. 

To show the variety of ways you can add and represent data in the system design repository, let’s switch 
to the N2 diagram to finish adding inputs and outputs. The N2 diagram will show the 
inputs/outputs between the Functions, but it excludes the sequence of events 
between the Functions, since it does not include a timeline or constructs. 

7. Click the N2 Diagram tab.  
8. Using the table below as your guide, complete the model using the same Shift-Click method. Add the 

following additional Items as triggers: products, status, customer certification request, tasks, and data. 
 

Item Output from Triggers 

products _Perform Geospatial Library Functions _Perform Customers 
Functions 

status _Perform Geospatial Library Functions _Perform Customers 
Functions 

customer 
certification request 

_Perform Geospatial Library Functions _Perform Certification 
Authority Functions 

customer 
certification 
response 

_Perform Certification Authority 
Functions 

_Perform Geospatial Library 
Functions 
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tasks _Perform Geospatial Library Functions _Perform Collectors 
Functions 

data _Perform Collectors Functions _Perform Geospatial Library 
Functions 

The resulting diagram should be similar to the following diagram: 

 

Deriving the Behavior for Our System 
Now that we have defined the context of our system, we will now decompose the root Function for our 
system _Perform Geospatial Library Functions. 

Because this tour is intended as an introduction to GENESYS we will not work through the entirety of the 
system. The Geospatial Library model is simply too complex to include all the details in this tour. 

We’ll focus instead on a very basic decomposition. If you would like to examine the full decomposition and 
system behavior of our sample project, you can do so by importing Geospatial Library Sample.gnsx found 
in the GENESYS 2024\Samples\Project Samples folder. (Importing projects was addressed earlier in 
Section 2 of the Guided Tour.) 

This work can be completed in either the EFFBD or the activity diagram. We will work on the activity 
diagram.  

Close the N2 diagram. 
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1. Select the _Perform Geospatial Library Functions entity in the Browser pane. 
2. Click the Views tab in the ribbon. 

 
3. Click the Activity Diagram icon on the ribbon to open the view in a new window. 

 

We’ll use the Toolbox exclusively during this process. Keep in mind that while we are building our diagram 
visually, GENESYS is building an actual data model, and all diagrams are visual representations of the 
underlying model. 

 
4. Drag the New Entity icon onto the diagram and drop it on the branch 

between the two end nodes. 

The New Entity command will prompt you for a name for the entity. Name the entity Accept Request. 

5. Drop another New Entity construct onto the branch AFTER the Accept Request entity. 
6. Name this second entity Check Product Inventory. 

The outcome of the Check Product Inventory function has two paths: in inventory and not in inventory. We 
will capture these options using multiple exit conditions from the Check Product Inventory function. 

 
7. From the Toolbox, drop the Exit Condition icon onto the Check Product 

Inventory Function. Click on the Exit folder and select New to add an Exit 
condition in inventory and click New again to add the second new Exit 
condition not in inventory. 

8. Click Close. 

Below is the activity diagram with this multi-exit function in place. 
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In this example, we will develop the [not in inventory] branch, to show the behavior of the system when this 
condition exists. 

9. Drop a New Entity construct onto the [not in inventory] branch. 
10. Name this entity Prioritize Request. 
11. Add another entity AFTER Prioritize Request named Determine Collector Mix. 

While our system is retrieving the image from the collectors, it will also notify the end-user of the estimated 
delivery schedule. We will use a Parallel construct to represent that both functions are executing 
concurrently. To show this: 

12. Drop a Parallel construct onto the end of the [not in inventory] branch. 

 

13. On the top branch of the Parallel construct drop a New Entity and name it Notify User of Estimated 
Schedule. 

14. On the bottom branch, drop a New Entity and name it Task Collectors. 
15. Now working at the end of the branch (after the Parallel construct), add two more entities in this 

order: 

a. Accept and Format Collector Products 

b. Put Product In Inventory 

 

The Accept and Format Collector Products icon may show truncated text in the ellipse (depending on 
your screen size and resolution). If this happens, the following steps can be taken to size the icon so that 
all text is viewable.  

16. Click in the background of the diagram to ensure that nothing is selected. 
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17. Click the Auto-size icon on the ribbon. NOTE: When the Auto-size icon is selected a dialog 
box appears: "Do you wish to resize all diagram content?" Select Yes.  

NOTE: This command can also be used to auto-size individual nodes. Select the desired node, then click 
the Auto-size icon. 

We are now finished developing the [not in inventory] branch and are ready to add two final entities to the 
end of the basic behavior of our system. 

18. Place two more New Entity constructs at the end of the primary branch. 
o Get Product From Inventory 
o Provide Product to Customer 

Compare your diagram to the one below. 

 

Adding Inputs and Outputs in an Activity Diagram 
To complete our behavior diagram, we need to add the inputs and outputs that occur between the functions. 
For the following steps, we will continue to work on an activity diagram. However, you can work in another 
behavioral diagram if you prefer. 

Just as we added triggers in the behavior diagram of our Context function, we will do the same for the 
Geospatial Library behavior. 

Note the difference between triggers and inputs. If a Function has a trigger, then the trigger is required to 
be present before the Function can execute. Inputs are not required for the Function execution.  

1. Add Items to the behavior model using the table below. None of these Items currently exist in our 
project, so you will need to create them as you go. Be careful to select the Connect via Input, 
Connect via Trigger, Edit Inputs, Edit Triggers, or Edit Outputs icons from the ribbon as 
appropriate. 
 

 

Items Actions on Functions 

output from inputs to triggers 
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formatted request Accept Request  Check Product 
Inventory 

approved request Prioritize Request  Determine Collector 
Mix 

collector mix Determine Collector 
Mix 

Task Collectors  

estimated delivery 
schedule 

Notify User of 
Estimated Schedule 

  

collector tasking Task Collectors   

collector data   Accept and Format 
Collector Products 

inventory product Get Product From 
Inventory 

 Provide Product to 
Customer 

 
After you have added your Items to the behavior view, take a moment to adjust the diagram for better layout 
and presentation. 

2. Use the Auto-size icon to expand nodes. 
3. Click and drag Items to reposition them if desired.  

 

The following images show both the activity diagram and EFFBD of the Geospatial Library entity. Compare 
your diagram to ensure completeness. 
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When you are satisfied, close both diagrams. 

Boolean Triggering Relationship Attribute 
Instead of a trigger relationship in behavioral diagrams, the inputs/input to relationship has a Boolean 
relationship attribute called Triggering. 

 

To change the Boolean value, double-click the Triggering attribute and select True or False at the Triggering 
window that appears.  
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Adding to the Traceability 
Now that we have defined our system and its behavior, let’s extend the requirements traceability to identify 
the functional entities that fulfill each functional requirement. Note that for model completeness, each 
functional requirement should trace to a function defined for our system. We will use the Browser pane to 
add these traceability relationships. 

1. In the Browser pane select the Requirement class and then the entity 3.1.2.2 Provide Products. 
Double-click the basis of relation to open an Edit Targets dialog. 

2. In the Edit Targets dialog, select target class Function. Select possible target Provide Product to 
Customer. Then click Add. Click Close. 

3. Use this process to complete the remainder of the basis of relationships shown in the table below. 
 

Requirement basis of Function 

4.1 Accept Requests Accept Request 

4.3 Control Multiple Collectors and Collector Types Determine Collector Mix 

4.6 Prioritize Requests Prioritize Request 

 
4. Select Requirement 4.0 Specific Requirements in the Browser pane. 
5. In the Views ribbon select Hierarchy to open a hierarchy diagram. Under “Stored Definitions” in 

the pulldown select Traceability and click OK. A "Save Changes before Proceeding?" dialog box 
will open. Click Yes. 

Compare the hierarchy diagram of the Specific Requirements entity to the one shown below. When you are 
satisfied, close the diagram. 
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5. EDITING FREE-FORM DIAGRAMS 
The Layout section of the Diagram ribbon contains commands for editing diagrams. The Route Lines and 
Distribute Lines commands apply to all the free-form diagrams (physical, internal, flow, interface, state 
transition, spider, parametric, and class block). 

 

Route Lines 

To route lines on a free-form diagram, select the Route Lines  icon. A drop-down menu containing 
three route line options (routing orthogonally, polyline, or straight line) appears.  

  
Each of the three options can be applied to all the lines in the diagram or selected lines.  

Recompute Connection Points and Port Locations 
When selecting the Layout and each of the Route Lines options, users can select an option to recompute 
the connection points and port locations, at the dialog box that displays.  

 
When the Recompute connection points and port locations option is checked, the layout algorithm will 
reposition the points where lines connect to nodes in the diagram to optimize the routing of the lines. 
Likewise, simple port nodes will also be repositioned to optimize the line routing. 
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Route All Lines Orthogonally with Recompute (Before) 
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Route All Lines Orthogonally with Recompute (After)  
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When the Recompute connection points and port locations option is not checked, the layout algorithm 
will maintain the points where lines connect to nodes in the diagram. The position of port nodes will also be 
maintained. 

Route All Lines Orthogonally without Recompute (Before)  
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Route All Lines Orthogonally without Recompute (After)  

 

Distribute Lines 

To evenly distribute all the node connections on the selected nodes, select the Distribute Lines 

 icon. 

The user can also click the arrow on the bottom of the icon to access a drop-down menu that contains 
options for evenly distributing node connections individually on any of the four faces (sides) of the selected 
nodes. 
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This feature also distributes port nodes on the diagram. The following example shows the application of 
Distribute Lines when applied to all nodes on the diagram.  

Distribute Lines (Before)  
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Distribute Lines (After) 

 

Port nodes are now considered anchored immediately after being added to a node on the diagram. They 
will no longer move to a new default location when new ports are added to the node. This prevents tedious 
rework as the layout of all connected lines was previously impacted. The new ports will be placed where 
there is open space on the left and right sides of the node to which the port is being added. 

Lines connected to port nodes will now exit the port away from the node on which the port resides. The 
diagram will also attempt to maintain this behavior as the user moves port nodes and nodes containing 
ports. This helps prevent tedious work to achieve an aesthetically pleasing diagram. 
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6. COMPLETING THE PHYSICAL MODEL 
This section will define the physical architecture for the Geospatial Library: 

• Create components comprising the system 
• Allocate functions to components 
• Create physical interfaces 
• Assess the model 

Extending the Component (Physical) Hierarchy 
Our next step is to determine how to decompose the Geospatial Library into its subsystems. 

Let us now assume that our Geospatial Library is built from two subsystem Components: Workstation and 
Command Center. 

1. In the Browser pane, create the two new Component entities, Workstation and Command Center. 
2. Assign their Numbers to SYS.1.1 and SYS.1.2, respectively. 
3. Set their Types to Subsystem. 
4. For each Component, establish the built in relationship with SYS.1 Geospatial Library as the 

target. (Note that built in is the inverse of the built from relation.) 
5. Now, open a BDD of the System Context Component. Do this by selecting the System Context 

entity, then clicking the BDD view tab.  

Compare your diagram to the one below. 

NOTE: You can also use the Physical Block diagram.  

 

When done close the BDD. 
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Allocating the Functions 
Now that we have completed both our behavior model and our physical hierarchy at this level, we will 
allocate the leaf-level Functions to the Components that will perform each function. The following EFFBDs 
illustrate how the Geospatial Library behavior was partitioned to the Workstation and Command Center. 

Notice that the Auto-allocation on Decomposition feature of the Model Assistant has automatically created 
root Functions for our new Components and established allocated to / performs relationships to the 
Components. 

1. In the Function class, select the _Perform Workstation Functions in the Browser pane. 
2. On the property sheet of the entity, under Relationships, double-click the decomposed by 

relationship to open an edit targets dialog. 
3. Add two Functions: Accept Request and Provide Product to Customer. 

We have now decomposed our _Perform Workstation Function into two child Functions: Accept Request 
and Provide Product to Customer. Compare your EFFBD to the one shown below. 

 

Completing the Physical Model 
By allocating our leaf-level Functions to Components, we have established the behavior of our 
subsystems. We will now formalize our logical interfaces establishing physical connections between our 
Components at the context level. 

The Link class is used to represent the physical connection between Components. 

NOTE: GENESYS users can also complete the steps on this page in the Physical N2 diagram. The layout 
is different, but the steps are the same. 

We will use the flow internal block diagram (flow IBD) to establish the physical links between the Geospatial 
Library and its external interfaces. The flow IBD will also allow us to show the items that are carried between 
the links, providing a detailed view of our architecture composition at the context level. 

1. In the Project Explorer pane, select Component. 
2. In the Browser pane, select System Context. 
3. Open a flow internal block diagram (flow IBD) diagram.  
4. Select the Geospatial Library entity. 
5. Shift-click to select Customers. 
6. Click the Connect Nodes icon on the ribbon and a connection Dialog box will pop up. 
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7. In the Connection Dialog, click on the Link folder and select New to create a new entity called 
Request-Product Link. Select New again to add another new entity called Status Link. 

8. Click Close. 
9. Repeat the process to add more connections as defined in the diagram below. 

The default layout for the links should be adjusted.  

10. Drag the nodes to arrange as displayed below. 
11. Drag the connections to lay them out as displayed below. To insert a bend, click in the background 

so that nothing is selected, then grab the line and drag. 

Now that we’ve established our Links, we need to define what each Link transfers between the 
Components. Earlier, we identified Items that are transferred when building our behavior model, and we 
will use those same Items to further define our system. 

12. In the Toolbox, click the Key Entities icon. 
13. Select the Item class to display the list of items. 

We can now drag-drop the needed Items onto the Links to establish that the Links transfer those Items. 
Each time you drag-drop an Item onto a Link, the relational dialog transferred by will confirm the 
relationship you are making. 

14. Use the diagram below as a reference to make additional relationships between Links and Items. 
15. The text on the line will be truncated. Select the text, then drag the handle to resize. 
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Impact Analysis 
To show the power of developing our system model with diagrams and seamlessly updating the integrated 
system design repository, we will walk through a typical systems engineering impact analysis using system 
diagrams. 

Suppose that the customer wants to know the impact of exchanging/replacing the Collectors. We can use 
the hierarchy diagram to show how a physical change to the system context can impact the system 
behavior. To do this: 

1. Select the Collectors Component. 
2. Click either the Spider icon or Hierarchy icon from the Views tab on the ribbon. 
3. Select Behavior Impact of Physical Change from the list of stored definitions and click OK. 

A diagram like the one below will open. This diagram allows us to visually identify all the Functions and 
Items associated with the selected Component, and now we can assess the impact of the system 
functionality due to a change to the external system. 
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Ensuring Full Traceability from Source Document to Physical Architecture 
Complete traceability within our model indicates which parts of a system design satisfy specific source 
Requirements and allows easy impact assessment of changes to system Requirements. Reverse 
traceability provides the ability to determine specific Components that have been defined without benefit 
of system analysis. Data traceability also allows for model consistency, which is difficult to attain when 
tracing entities from document to document without the benefit of an integrated design repository. This 
means that all incompatibilities are checked and resolved, the design is complete (all interfaces and 
environments are specified), and the design is feasible (all critical entities are demonstrated). 

Using relationships for traceability makes it easy to detect unfulfilled Requirements and unresolved 
Concerns. 

1 Close the Hierarchy Diagram window. 
2 Select the Requirement class in the Project Explorer pane. 
3 At the bottom of the Browser pane, select Unaddressed Requirements from the filter drop-down list.  

This will filter the entity list to display only those Requirements that do not have targets for the basis of, 
refined by, and specifies relations. 

For example, we see that Requirement 4.4 Maximum Staff has not yet been addressed. A traceability 
hierarchy diagram does not have to be opened to determine that 4.4 has not yet been addressed. 
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4 Reset the filter to All Entities. 
 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Selecting the Scripting Language 
GENESYS users can select the scripting language, in User Preferences, to use in GENESYS. 

1. Access User Preferences by selecting the File menu, then clicking the Preferences button at the 
bottom right side of the menu that appears.  
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2. Under User Preferences, select the General preferences. 

 

3. In the General Options section of the window that displays, select the scripting language from the 
drop-down list on the Default Script Language field. 

GENESYS supports Visual Basic and C# scripting languages. The default language is Visual Basic.  
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GENSYS users also have the option to select the language when creating a new script.  

1. On the Utilities tab, select the Scripts  icon, New Script, and then select the language from 
the Script Language drop-down list. This will override the default script language set in User 
Preferences.  
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The scripting language is also displayed as a read-only field on the script property sheet, as shown below. 

 

Change Control 
GENESYS provides several mechanisms for identifying and tracking changes to the repository. These 
include Audit Logs, Versioning, and a Project Compare Report. 

Audits Logs provide a history of changes to an entity. When a new project is created, Audit Logs are enabled 
by default. 
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The Audit Log is accessed through a property sheet’s Properties tab. 

 

The log identifies when the change was made, by whom, and the nature of the change. Versioning provides 
a more detailed view of changes to an entity’s attributes. When an attribute is changed the Version 

Browser icon becomes highlighted. Select the icon  to open a Versioning dialog.  
 

The dialog identifies when the change was made, by whom, and the attribute’s value. The bottom value is 
the entities baseline. The top value is the entities current value. Pressing the Restore button makes the 
highlighted value the current value with its original timestamp. 

In the Project tab of the ribbon, you’ll find the commands to Purge Versions and Baseline Versions. 
Purge Versions removes all interim values leaving the current and baseline values. Baseline Versions 
removes all values except the current, which becomes the baseline. These apply to the entire project. 
Selective purging and baselining can be done using the Purge Versions and Baseline Version commands 
from the entity right-click menu. The Attribute History Report prints the version history for selected entities 
and attributes. 

There is another report known as Project Compare. This report is a comprehensive comparison of two 
projects. It lists new and deleted entities, changes to attributes and relations, and identifies when a diagram 
has been modified. 
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7. CREATING CUSTOMIZED VIEWPOINTS OF THE DATA MODEL  
GENESYS users can create customized perspectives of a project model’s data that address sets of 
stakeholder concerns. These perspectives, called Viewpoints, are like reusable queries that define the 
content and rules for constructing a view of the model. They can incorporate the specialized language of 
any profession or stakeholder community. A view is a representation of the system from the perspective of 
a single viewpoint. 

When GENESYS applies a viewpoint to a set of entities, GENESYS outputs the desired properties, 
attributes, parameters, relationships, and relationship attributes. 

A viewpoint consists of one or more masks, mappings, and filters, as described next. 

Masks 
The Masks feature provides the capability to hide entities, attributes, parameters, parameter fields, 
properties, and/or relationships, enabling you to focus only on the subset of the schema that the audience 
for your viewpoint needs to see. 

To access the Masks feature in GENESYS, click the arrow next to Utilities in the Project Explorer pane and 
then select Masks. 

The available masks, if any, are displayed in the Browser pane.  

 

Creating a New Mask 
To create a new mask: 

1. Enter a name for the new mask in the box at the top of the Browser pane and then click Create. 
Alternatively, right-click in the Browser pane and select New Mask from the drop-down list that 
appears, and then enter a name for the new mask in the window that displays. 
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The new mask appears in the pane.  

2. All the entities, attributes, parameters, properties, and relationships in the project appear in the 
Mask Selections section in the center of the window. Select the items to include in the mask.  

Choose Select All or Clear All to select or clear all the items at once, respectively. 

3. Select the fields to include as parameters in the mask in the Parameter Fields section at the bottom 
of the window. Available parameter fields include objective, minimum, maximum, units, design, 
observed and precision. 

Deleting a Mask 
To delete a mask: 

1. Right-click on the mask that you want to delete in the Browser pane and select Delete on the drop-
down menu that appears or click the Delete key on your keyboard.  

The mask disappears from the list.  

Mappings 
The Mappings feature provides the capability to translate terms (i.e., class names, attribute names, 
parameter names, relationship names, relationship attribute names, parameter fields, etc.) used in 
GENESYS to the specialized language of particular disciplines or stakeholder communities. For instance, 
for an electrical engineer, the word “item” can be mapped to the word “signal” and the word “link” can be 
mapped to the word “trace”, etc.  

To access the Mappings feature in GENESYS, click the arrow next to Utilities in the Project Explorer pane 
and then select Mappings. 
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The available mappings are displayed in the Browser pane.  

 

Creating a New Mapping 
To create a new mapping: 

1. Enter a name for the new mapping in the box at the top of the Browser pane and then click Create. 
Alternatively, right-click in the Browser pane and select New Mapping from the drop-down menu 
that appears, and then enter a name for the new mapping in the window that displays. 

 

The new mapping appears in the Browser pane.  

Creating a New Global or Local Mapping Item 
To create a new global or local mapping item: 

1. Select the green Insert  icon at the top of the Global pane in the center of the window. A new 
mapping item appears in the pane. The original name for the item appears on the left side and the 
new mapping name appears on the right side. You have the option to keep the default name for 
the mapping item, Mapping_###, or rename it. This section of the window is for specifying global 
mappings that will globally replace the specified definition names every place that they appear in 
the viewpoint. 
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2. You can also specify local mappings that take precedence over the global mappings and apply only 
to the specified definition. In the Local pane on the right side of the window, click the arrows next 
to the items that you want to map and next to any attributes, relationships, etc. under these items. 
To define a local mapping, scroll through the GENESYS items and rename any of them with 
specialized language. In the example above, we renamed “number” to “WireNumber” in the 
Electrical Wiring mapping.  

To expand all the items in the Local section at once, click the Expand All  icon on the top right 
side of the window section, or to collapse all the items, select the Collapse All  

 icon.  

 To clear all the items that you selected, select Clear All on the top right side of the window section. 

3. You also have the option to rename any of the parameter fields in the Parameter Fields section at 
the bottom of the window.  

Deleting a Mapping Item 
To delete a mapping item: 

1. Highlight the mapping item that you want to delete and select the Delete  icon at the top of the 
Mapping Items pane.  

The mapping item disappears from the list.  

Deleting a Mapping 
To delete a mapping: 

1. Right-click on the mapping that you want to delete in the Browser pane and select Delete on the 
drop-down menu that appears or click the Delete key on your keyboard.  

The mapping disappears from the list.  

Filters 
With a filter, you can narrow a large amount of data down to the specific data that you want.  

To access the filters in GENESYS, click the arrow next to Utilities in the Project Explorer pane and then 
select Filters. 

The available filters display in the Browser pane.  
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Highlight the filters that you want in the Browser pane. 

 

Creating a New Filter 
To create a new filter: 

1. Enter a name for the new filter in the box at the top of the Browser pane and then click Create. 
Alternatively, right-click in the Browser pane, select New Filter from the drop-down menu that 
appears, and then enter a name for the new filter in the window that displays.  

 

The new filter appears in the pane.  

2. Filter criteria for the selected filter displays in the Filter Criteria section of the window.  
3. Select AND or OR at the top of the Filter Criteria section to form a logical AND or OR statement, 

respectively, for the filter criteria. 
4. Select the criteria that you want to apply to the filter, and depending on the options that you select, 

enter values or select additional options or operators to specify the criteria for the filter.  

5. To add additional criteria to the filter, click the green Insert  icon at the top of the Filter Criteria 
section, or right-click a filter criterion and select Add Filter Criterion from the drop-down menu that 
appears, and then specify the additional filter criteria.  
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Sorting Filter Criteria 
1. To sort filter criteria in a different order, highlight a filter criterion in the window and click the green 

Move Up or Move Down arrow to move the filter criterion up or down, respectively, in the 
list. Alternatively, right-click on the filter criterion and select the Move Up or Move Down arrows 
from the drop-down menu that appears. 

 

Deleting Filter Criteria 
To delete filter criteria: 

1. Highlight the filter criterion that you want to delete and click the Delete  icon at the top of the 
Filter Criteria section, or right-click on the filter criterion and select Remove Filter Criterion on the 
drop-down menu that appears.  

The filter criterion disappears from the list.  

Deleting a Filter 
To delete a filter: 

1. Right-click on the filter that you want to delete in the Browser pane and select Delete on the drop-
down menu that appears or click the Delete key on your keyboard.  

The filter disappears from the list.  

NOTE: If the Essential checkbox on the top right corner of the Mask/Mappings/Viewpoint/Filter window is 
checked, this indicates that the selected mask/mappings/viewpoint/filter is essential to the model and 
cannot be deleted. Normally, this option can only be set by the GENESYS Team and GENESYS users do 
not set it. 

Viewpoints 
To access the Viewpoints feature in GENESYS, click the arrow next to Utilities in the Project Explorer pane 
and then select Viewpoints. 

The available viewpoints are displayed in the Browser pane.  
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Highlight the viewpoint that you want to view, in the Browser pane. 

 

Creating a New Viewpoint 
To create a new viewpoint 

1. Enter a name for the new viewpoint in the box at the top of the Browser pane and then click Create. 
Alternatively, right-click in the Browser pane and select New Viewpoint from the drop-down menu 
that appears, and then enter a name for the new viewpoint in the window that displays.  

 

The new viewpoint appears in the pane.  

2. Select filters to apply to the viewpoint by highlighting them in the Available Filters section in the 
center of the window and clicking Add. The selected filters will appear in the Selected Filters box 
on the right side of the window.  

To remove any filters, highlight them in the Selected Filters section on the right side of the window and click 
Remove. 

3. Check the Filter Targets checkbox at the top of the Available Filters window section if you want to 
include only entities that satisfy all filters in the resulting data set.  

4. Select the mask and mapping to use for the selected viewpoint in the Mask and Mapping section 
at the bottom of the window.  
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To delete the mask or mapping that you selected, click the Delete  icon next to the Mask or Mapping 
field.  

Sorting Filters 

To sort the filters you selected in a different order, highlight the filter and click the green Move Up or 

Move Down arrow to move the filter up or down, respectively, in the list. 

 

Deleting a Viewpoint 
To delete a viewpoint: 

1. Right-click on the viewpoint that you want to delete in the Browser pane and select Delete on the 
drop-down menu that appears or click the Delete key on your keyboard.  

The viewpoint disappears from the list.  

NOTE: Masks, mappings, and viewpoints can be imported and exported into other projects. 

Rule Sets 
Rule sets enable users to create rules for automatically formatting many features of a diagram. Applying a 
rule set to a diagram significantly saves time in creating and maintaining diagrams.  

To access rule sets in GENESYS, click the arrow next to Utilities in the Project Explorer pane and then 
select Rule Sets. 
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The available rule sets display in the Browser pane.  

 

Highlight the rule set that you want to view, in the Browser pane, and then select the Diagram Rules, Node 
Rules, or User Rules tab at the bottom of the Rules pane, to access the available diagram rules, node 
rules, or user rules, respectively, for that rule set. 
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The available rules for that rule set display in the Rules pane, as shown below: 

 

Highlight the rule that you want to view.  

In the screen above, the Diagnostic Errors rule colors the background of any nodes on the diagram that 
contain diagnostic errors in red.  

Creating a New Rule Set 
To create a new rule set: 

1. Enter a name for the new rule set in the box at the top of the Browser pane and then click Create. 
Alternatively, right-click in the Browser pane, select New Rule Set from the drop-down menu that 
appears, and then enter a name for the new rule set in the window that displays.  

 

The new rule set appears in the pane.  

Deleting a Rule Set 
To delete a rule set: 

1. Right-click on the rule set that you want to delete in the Browser pane and select Delete on the 
drop-down menu that appears or click the Delete key on your keyboard.  

The rule set disappears from the list.  
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Creating a New Rule 
To create a new rule: 

1. Make sure that the rule set for which you are creating a new rule is highlighted in the Browser pane. 

2. Select the Diagram Rules, Node Rules, or User Rules tab at the bottom of the Rules pane, to 
create a diagram rule, node rule, or user rule, respectively. 

3. Select the green Insert  icon at the top of the Rules pane, or right-click on a rule listed in the 
pane and select Insert from the drop-down menu that appears.  

A new rule appears in the pane with the default name “Rule_###”.  

4. In the Diagram/Nodes/User Rules section on the right side of the window, enter a new name for 
the rule or keep the default name. 

 

5. Select the checkboxes next to Show on Legend, Stop Evaluation and Disabled, for any options that 
you want.  

6. If you select Show on Legend, enter a label for the legend in the Legend Label box.  
If you select Stop Evaluation, the rule will appear with a red block next to it in the window. Since 
the rules are executed in the model in the order that they are listed in the window, this indicates 
that the rules will stop executing after Rule_001.  
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If you select Disabled, the rule will be disabled and will appear with a red circle with a line through 
it in the window.  

 

7. Add a condition to the rule by selecting the green Insert  icon in the Conditions section of the 
window, or right-click on a condition listed in the window and select Insert from the drop-down menu 
that appears.  

8. To construct the condition, first select the Type from the drop-down list. Options include Always 
Attribute, Class, Construct, Diagnostic Errors, Node Type, Parameter, Target, or Target Entity. 

 

9. Then, depending on what option you selected, select additional options or operators from the drop-
down lists to construct a conditional expression that determines what automatic formatting will be 
applied to the items you selected. 

10. Add an action to the rule by selecting the green Insert  icon in the Actions section at the bottom 
of the window, or right-click on an action listed in the window and select Insert from the drop-down 
menu that appears. Then select the Type from the drop-down list. Options include Border/Line 
Style, Border/Line Weight, Color Fill, Color Line, Color Text, Elision, Node Image, Node Shape, 
Node Show Image, Template, Text Bold, Text Italic, or Text Strikethrough. Depending on what 
option you selected, select any additional options.  
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By combining conditions and actions and multiple rules, GENESYS users can automatically format many 
items in their models. 
 
A few examples are below: 

 Show the computer nodes as computer images on the diagram.  
 Show mechanical nodes in the diagram in purple and electrical nodes in yellow. 
 Show external nodes in black. 
 Show the nodes and connecting lines in green if the Cost attribute for the nodes is < $300,000. 

Sorting Rules, Rule Conditions or Rule Actions 
To sort the rules, rule conditions, or rule actions in a different order, highlight the rule, condition, or action 

in the window and click the green Move Up or Move Down arrow to move the rule, condition, or 
action up or down, respectively, in the list. Alternatively, right-click on the rule, condition, or action and select 
the Move Up or Move Down arrows from the drop-down menu that appears. 

 

Deleting a Rule, Rule Condition or Rule Action 
To delete a rule, rule condition, or rule action: 

1. Highlight the rule, condition, or action that you want to delete in the window and select the Delete 

 icon at the top of the Rules, Conditions, or Actions pane, or right-click on the rule, condition, 
or action and select Remove from the drop-down menu that appears.  

The rule, rule condition, or rule action disappears from the list.  

Duplicating a Mask/Mappings/Viewpoint/Filter/Rule Set 
To duplicate a mask/mappings/viewpoint/filter/rule set: 

1. Right-click on the mask/mappings/viewpoint/filter/rule set that you want to duplicate in the Browser 
pane of the Mask/Mappings/Viewpoint/Filter/Rule Set window and select Duplicate on the drop-
down menu that appears. 

 

A copy of the mask/mappings/viewpoint/filter/rule set with the same content appears in the Browser pane. 

The duplicate feature saves time when you want to create a new mask/mappings/viewpoint/filter/rule set 
that contains similar content to ones already created. After it is created, you can customize the new 
mask/mappings/viewpoint/filter/rule set.  



Systems Engineering Guided Tour 

104 

Applying a Rule Set to a Diagram 
To apply a rule set to a diagram, open the diagram and in the Properties tab of the diagram Toolbox, select 
the rule set from the Rule Set drop-down list. 

 

The image below shows the Diagnostic Color Coding rule set applying red color coding to the nodes with 
errors in the Constraint Block Definition Diagram (BDD) of the Geospatial Library. 
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If you want to revise a rule or rule set, or create a new one, you can perform this task directly from the 
diagram Toolbox by selecting Create or Edit under the Rule Set drop-down. 

 

Rule Set Diagram Legends 
GENESYS has the capability to add automatically generated legends based on rule sets to diagrams. 
These legends explain the rule-based formatting of the diagrams. The formatting rules can apply to the 
entire diagram, all the nodes/lines/other items in the diagram, or to specific nodes/lines/items in the 
diagram.  

These legends add an enormous amount of meaning to the diagrams through visual classification cues, as 
shown below. At a glance, you can tell that all red blocks on the diagram are diagnostic errors.  

 

Users also have the option to set many other properties of the rule set legend in the Properties tab of the 
diagram toolbox or in Project Preferences, including font size, text/line/fill color, node/line/label width, and 
node height. Additional options include adding a title to the legend, making the labels the same width as 
the nodes, and proportionally sizing the nodes and lines. The local settings in the Toolbox override the 
global settings in Project Preferences. 
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To add a rule set legend to a diagram, you must first select Show a Legend when creating the associated 
rule set and then check Show Legend in the diagram toolbox properties.  
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By default, the legend is placed on the bottom right side of the diagram, although users can re-position it 
by selecting another option (bottom left, floating, top left, or top right) from the Dock Legend drop-down list 
in the Properties tab of the diagram toolbox. Users can also drag-drop the legend any place on the diagram.  

 

Another example is shown below. The rule sets that apply to this diagram display the node types in assorted 
colors. 
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The diagram legend shows at a glance that purple nodes are services, and green nodes are systems and 
subsystems.  
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Generating RDF Files with Viewpoints 
GENESYS now supports generating Resource Description Framework (RDF) files with viewpoints. The 
generated RDF files are representations of the GENESYS data and can be processed by tools that use the 
RDF standard.  

The RDF connector, CompressionTurtleWriter, is replacing the former RDF connector in GENESYS since 
it uses a fuller range of syntax compressions. 
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1. To access this feature, on the Utilities ribbon, select Generate RDF. 

 

The Generate RDF Wizard displays. 
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2. At the first window of the wizard, select the scope of the submodel. Options include Project, Folder, 
or Package. Then click Next. 

In our sample below, we are selecting Project. 

If you select Folder or Package, the available folders or packages in the project appear on the 
window for you to select, as shown below: 
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3. At the second wizard window, select a viewpoint. 

 

You have the option to select the box to include context entities.  
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4. Enter a name for the generated file, optionally browse to a location to store the file or accept the default 
location and select a file type. 

NOTE: The generate RDF feature in GENESYS supports the two most popular file formats for 
generating RDF files: RDF (.rdf/xml) and terse RDF triple language (turtle) (.tll). 

You have the option to select the box to export relationships as simple predicates. This will simplify 
the representation.  

CAUTION! When relationships are exported as simple predicates, the relationship attributes will 
not be included.  

5. Click Generate. 
Access the generated file at the location specified in the window above. 

Sample RDF and turtle files are shown below. 

 
RDF FILE 
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TURTLE FILE 

The generated file contains the entities included in the viewpoint in alphabetical order by class name. Then 
entities, attributes, properties, and parameters will also be listed in alphabetical order under each class. 
Relationship information will also be included. 

 
The generated file is encoded with the RDF standard.  
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8. CREATING MULTIPLE VIEWS OF A DIAGRAM 
GENESYS has the capability to create multiple views of a diagram. This feature enables GENESYS users 
to create several versions of the same diagram with different properties, styles and templates containing 
different information. It also saves time for GENESYS users since they can create new views from 
previously formatted views or from the default view. 

The sample below shows the default view for the Geospatial Library EFFBD diagram, created with a 
template containing name, number and allocation information and with yellow fill color selected for the 
nodes.  

 

Creating a New View Based on the Default View 
1. To create a new view of the diagram based on the default layout of the diagram, select the  

View  icon on the Diagram tab and select New on the drop-down menu.  
2. Enter a name for the new view in the window that displays. 

 

A new view with the same layout as the original view is created with the new name that you assigned. 
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Creating a New View Based on Another Formatted View 
If you add new formatting to a view using the toolbox properties and then save it with a new name by 
clicking Save on the Diagram ribbon, you can base other views on this formatted view.  

1. Open the view that you want to base a new view on, add any additional formatting changes, and 
then click Save As on the Diagram ribbon to save the new view with a new name. 

The view below, named Light Blue_Name Operations, created from the same diagram, was based on a 
previously formatted view that used a template containing name and operations information and light blue 
fill color selected for the nodes.  

 

Viewing All Available Views for a Diagram 

To view all available views for a diagram, select the View  icon on the Diagram tab and select the one 
that you want from the drop-down menu.  
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Displaying View Metadata 
To display view metadata, select the Views tab at the bottom of an entity’s property sheet. The Views tab 
lists all views that exist for an entity. The metadata includes diagram type, view name, whether it is the 
default view, created by, created date and time, modified by, and modified date and time. These fields 
dynamically update as the view metadata changes.  

 

Preventing Accidently Overwriting a View 

A warning message is displayed to prevent GENESYS users from accidentally overwriting a view. This can 
happen when two users are working on the same view concurrently, or if a GENESYS user has the same 
view open in multiple windows. 
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When the user attempts to save the diagram, and the view was saved by another window or user since the 
diagram was opened, a warning message displays with options to save the diagram as a new view with a 
different name, overwrite the view, or cancel the changes to the view.  

 

If the user attempts to close the diagram window without saving it, and the view was saved by another window 
or user since the diagram was opened, the following warning message displays with an additional option to 
discard the new view.  

 

Saving a Diagram as an Image 

To save a diagram as an image, select Save on the Diagram ribbon and Save As Image on the drop-down 
menu that appears, then enter a name for the image, and browse to the location where you want to save it. 

Displaying Multiple Diagram Views on Reports 
GENESYS has the capability to display multiple diagram views on reports. 

1. In Project Explorer under Reports, select the report category that you want to view.  

All the reports in that category are displayed in the Browser pane in the center of the window.  

In the example below, we selected SDD reports and the SDD Report by Component. 
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Systems Engineering Guided Tour 

120 

2. Select the report section or subreport where you want the multiple views to display by clicking the 
arrow next to the report category (in this case SDD reports) in Project Explorer.  

3. Then select the Sections or Subreports folder that contains the section or subreport you want to 
edit.  

The list of report sections or subreports will be displayed in the Browser pane.  

4. Right-click on the report section or subreport that you want to edit and then select Edit on the drop-
down menu that appears. 
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The Report Designer where you edit the report opens. 

 

5. Find the report section or subreport you want to edit in the center of the window and then click the 
button next to it that looks like a greater than symbol . 
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 The following window appears.  

6. Select All Views for the View Output field. By default, the default view displays.  

 

7. To filter which views display, enter a filter in the View Name Filter field. For example, if you enter 
“Main”, all views with “Main” in the name will display.  

You can also use a wildcard filter by entering a part of the name followed by an asterisk (i.e., “ma*” and 
all views starting with the letters “ma” will display on the report. 



Systems Engineering Guided Tour 

123 

8. To run the report to see the multiple views, right-click on the report name and then select Run on 
the drop-down menu that displays.  

 

9. Select a location to save the report.  

10. Then, select the parameters for the report in the dialog box that appears. 
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Multiple views of the System Context, Physical Block diagram display on the SDD Report by Component 
report shown below. 

 

9. STRUCTURED VIEWS OF DIAGRAMS 
Structured views of diagrams enable GENESYS users to create lists of diagram views that direct modelers 
and other GENESYS users to the important diagrams for various tasks and purposes. Modelers can use 
these view lists to create model overview roadmaps, to build lists of diagrams for design review 
presentations, or to export to share with external stakeholders, and for many other purposes. The view lists 
can also contain Table Views. 

GENESYS contains four types of structured view lists: 

 Project Pinned - enables a modeling team to flag (pin) views important to the team. 

 User Favorites - enables team members to flag diagrams that are most important to their 
individual work and current views that they are working on. 

 Filtered – enables users to filter the views based on specific criteria. 

 Custom – enables users to create customized lists of views for specialized purposes. 

Project Pinned, User Favorites, Filtered, and Custom view lists are viewable by all users with access to 
the project. Each user can view only their own User Favorites list. 
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To save time creating view lists, users can modify an existing view list and save it with a new name. They 
can also create variants of lists for various applications of the modeling team.  

Users can also flag diagram views in view lists to find them more easily.  

By selecting a Pin  or Star  icon on the Diagram ribbon when working on a diagram, or on any of 
the view lists, users can add the diagram to the Project Pinned or User Favorites view list, respectively. 

The Star  icon will change color to yellow, indicating that the diagram is a User’s Favorite diagram, 

and the Pin icon will change color to blue to indicate that the diagram is on the Project Pinned view 
list, making the diagram types easily recognizable. 

They can also add diagrams to any Custom view list from the view lists or by selecting the View List 

Membership  button on the Diagram ribbon. 

Users can remove diagrams from the view lists by selecting the icons on the Diagram ribbon or on the view 
lists. These actions can be undone/redone by selecting the Undo and Redo icons. 

If another user adds a diagram to the Project Pinned, User Favorites, or Custom view lists, that diagram 
will dynamically appear in the relevant view list. 

The view lists feature includes extensive search functionality. Users can search for saved diagram views 
by diagram name, diagram type, and class making all the diagrams in the system easily accessible. The 
Views search also includes Table Views. 
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GENESYS saves the search results in the Search Results section of Project Explorer, making them 
available for future reference and for easy access. Users can conveniently drag-drop the search results 
from the View Search Results window directly to the Project Pinned/User Favorites/Custom view lists.  

For additional information about structured views of diagrams, refer to the online help.  

10. TABLE VIEWS 
The Table Views feature in GENESYS enables users to view table views of GENESYS data within 
GENESYS instead of having to export the data to Excel. Table Views are an excellent way to work with the 
entities in a model and present them with their associated attributes and relationships. They make the 
modeling data easily accessible and easy for users from various disciplines to comprehend.  

Table Views includes a powerful editing feature that accesses all the built-in editors in GENESYS including 
the Scripts Editor, Number Specs Editor, Entity Reference Editor, and Reference Spec Editor where users 
can edit the data directly in GENESYS. Everything editable in an entity property sheet in GENESYS is also 
editable in a Table View and is saved in the GENESYS database. It’s also possible to add new entities 
directly into GENESYS from a Table View. 

Table Views also dynamically update when data in GENESYS changes.  

Table Views can be based on various pre-formatted templates called Table Definitions and can include 
packages, folders, or classes. Users can also edit the Table Definition for a Table View from within 
GENESYS just like they would edit it in Excel and create customized Table Definitions.  

The Table View shown below is based on the Requirements Table Definition.  

 
Data can be copied and pasted from a Table View into MS Excel where users can manipulate the data with 
advanced Excel features.  

For additional information about Table Views, refer to the online help. 
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11. MATRIX VIEWS 
What it is 
Matrix Views are a data visualization grid that shows the relationships between entities in a system. The 
Matrix View feature is a powerful tool for gaining insights into complex systems by providing a customized 
visual representation of how individual entities are related within a class and scope. In GENESYS, Matrix 
Views are part of the suite of Independent View types. 

Why it is useful 
Use a Matrix View to identify gaps in your project’s traceability or to show traceability coverage. For 
example, Matrix Views can demonstrate how system requirements are linked to lower-level design 
requirements, providing a way to visually verify that all requirements are adequately flowed down and 
connected across different system levels.  

Another application example is to use Matrix Views to visually verify that all requirements and functions are 
allocated to components in the physical architecture. Users have the flexibility to create as many Matrix 
Views as needed, each dynamically adjustable to include different entities, ensuring that each Matrix View 
is tailored to meet specific project needs. Matrix Views can help to flag areas where entities may not have 
been properly related or allocated to other portions of the systems architecture model, providing a visual 
indication of completeness.  

How to use it 
Users specify the Class and Scope for the rows and columns of the Matrix View and choose which 
Dependency Relationships to display in the grid. Matrix Views can display one or more Dependency 
Relationship types between a Source and a Target. These relationships are visualized with color-coded 
arrows or text strings. The Matrix Views feature has the functionality to edit Relationships in real time or 
remove Relationships as needed, allowing users to address any gaps or inconsistencies in requirement 
coverage immediately. For easy reference, a Matrix View can be exported for use on other platforms. 

Matrix View example 
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12. GENERATING DOCUMENTATION 
In this section, you will generate outputs from GENESYS. 

• Output a System Description Document 
• Generate TeamView 
• Review Standard Reports available in GENESYS 

Generating a System Description Document (SDD) 
A System Description Document (SDD) presents your project’s primary systems engineering entities in a 
structured manner for reviewing your physical and behavior model and related information. For each entity 
appearing in the SDD, key attributes and relations are listed. User-selected diagram types are also included, 
as appropriate. 

Typically, an SDD is generated for the system or one of its lower-level Components. Only the entities 
directly or indirectly related to the selected Component and its physical hierarchy are included. 
Alternatively, all systems engineering entities can be included. 

1. In the Project Explorer pane, expand the Reports branch. 
2. Select the SDD folder. 
3. In the Browser pane, select SDD Report (by Component). 
4. Right-click on the report and select Run. 
5. When prompted for the file name and location, review these, set as desired, and click Save. 
6. In the Parameters dialog, select Geospatial Library, then click Submit. 

 

You will see this dialog while the report runs. The report will be finished when this dialog closes.  

 

7. Navigate to the location where you saved the file and double-click to open. 
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Generating TeamView 
Another report available in GENESYS outputs the contents of the system design repository in HTML format 
and generates a Home Page accessible by anyone with a Web browser.  

1. Click the Export TeamView  icon on the Utilities ribbon. 
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2. Select a location where the report Home Page can be saved by clicking on the Ellipsis button next 
to the Save files to directory field at the top of the window. (Make sure that you create a folder for 
the output since it may contain hundreds of files.) 

3. Select other options on the window as desired or leave the default settings. 
o Show blank attributes - can be used as a diagnostic to see what attributes are not filled in. 
o Sort entity and target lists by number - No will sort and show lists alphabetically. 
o Diagram Views - Only show the default view for each diagram or all stored views. 
o View Name Filter - Used in conjunction with All Diagram Views to filter based on view name 

(wildcard * and ? can be used for matching names.) 
o Default to Graphical View - Default view is a property sheet. Selecting this option will default 

to a diagram view based on the default view in the script. 
4. Click Generate. 

You will be prompted when TeamView completes processing. 
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5. Click Yes to launch TeamView in your default web browser. 

 

Clicking on a class/folder link in the left-hand list displays the corresponding entities on the right. From this 
list, you can select any entity to display its property sheet. 

6. For example, click on the Component link. On the right, a list of all entities in the Component class 
is displayed. 

7. Click on C System Context to show the property sheet. 
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If All Views is selected for Diagram Views, a View drop-down list appears on the top right side of the page, 
listing all the views for the entity. When users select a type, the associated view is automatically selected.  

At the Type drop-down list above the View drop-down list, if Property Sheet is selected for the Type, Default 
will be selected automatically as the view, as shown above. 

8. In the Relationships portion of the entity information, each relationship Target is a link to the text 
view for that entity. If the selected function has a diagram associated with it, users can access the 
diagram by selecting the link from the Type drop-down list located at the top of the text view. 

In the example below, we selected the Requirement class/folder and the Performance Self-Assessment 
entity within this class. Since this entity contains multiple views, when we select Hierarchy – Traceability for 
the Type, the Hierarchy – Traceability view is selected for the view at the View drop-down list. This diagram 
will display in the window in place of the entity attributes and relationships. Each Entity and Link icon is a 
hyperlink to that entity. 
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9. Close the browser. 

Congratulations! 
You have completed your first system design using GENESYS. Now, it’s time to save your final model. 

With this guided tour as a desktop reference, experiment by designing your own system. Remember that 
GENESYS is far more powerful and flexible than we have shown in this simple example. Experiment with 
the other features and capabilities to get a better idea of what you can do. In fact, you will discover that with 
GENESYS, you’ll have more time for engineering your system. 

Systems engineering should be productive and fun. We believe that using GENESYS is both. 
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13. STANDARD REPORTS AVAILABLE IN GENESYS 
 
Attribute History 

• Attribute History Report 

Common Subreports 
• Augmentation Output 
• External File Figure 
• Relationship Targets 
• TOC_List of Figures 
• TOC_List of Tables 
• TOC_Table of Contents 

Diagnostics 
• Diagnostics Results Report v1.0 
• Diagnostics Table Report v1.0 

DoDAF 
• AV-1 Overview and Summary 

Information 
• AV-2 Integrated Dictionary 
• CV-1 Vision 
• CV-2 Capability Taxonomy 
• CV-3 Capability Phasing 
• CV-4 Capability Dependencies 
• CV-5 Capability to Organizational 

Development Mapping 
• CV-6 Capability to Operational Activities 

Mapping 
• CV-7 Capability to Services Mapping 
• DIV-1 Conceptual Data Model 
• DIV-2 Logical Data Model 
• DIV-3 Physical Data Model 
• OV-1 High-Level Operational Concept 

Graphic 
• OV-2 Operational Resource Flow 

Description 
• OV-3 Operational Resource Flow Matrix 
• OV-4 Organizational Relationships 

Chart 
• OV-5a Operational Activity 

Decomposition Tree 
• OV-5b Operational Activity Model  
• OV-6a Operational Rules Model 
• OV-6b State Transition Description 
• OV-6c Event-Trace Description 
• PV-1 Project Portfolio Relationships 
• PV-2 Project Timelines 
• PV-3 Project to Capability Mapping 
• StdV-1 Standards Profile 
• StdV-2 Standards Forecast 
• SvcV-1 Services Context Description 
• SvcV-2 Services Resource Flow 

Description 

• SvcV-3a Systems-Services Matrix 
• SvcV-3b Services-Services Matrix 
• SvcV-4 Services Functionality 

Description 
• SvcV-5 Operational Activity to Services 

Traceability Matrix 
• SvcV-6 Services Resource Flow Matrix 
• SvcV-7 Services Measures Matrix 
• SvcV-8 Services Evolution Description 
• SvcV-9 Services Technology & Skills 

Forecast 
• SvcV-10a Services Rules Model 
• SvcV-10b Services State Transition 

Description 
• SvcV-10c Services Event-Trace 

Description 
• SV-1 Systems Interface Description 
• SV-2 Systems Resource Flow 

Description 
• SV-3 Systems-Systems Matrix 
• SV-4 Systems Functionality Description 
• SV-5a Operational Activity to Systems 

Function Traceability Matrix 
• SV-5b Operational Activity to Systems 

Traceability Matrix 
• SV-6 Systems Resource Flow Matrix 
• SV-7 Systems Measures Matrix 
• SV-8 Systems Evolution Description 
• SV-9 Systems Technology & Skills 

Forecast 
• SV-10a Systems Rules Model 
• SV-10b Systems State Transition 

Description 
• SV-10c Systems Event-Trace 

Description 

IRS 
• IRS Report 

Project Compare 
• Project Compare Report 

Reporting Toolkit 
• Closed Concerns Report 
• Component Hierarchy Report 
• Cross Reference Matrix Report 
• Functional Hierarchy Report 
• Open Concerns Report 
• Requirements Hierarchy Report 
• Work Breakdown Structure (WBS) 

Report 
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Risk Report 
• Risk Report 

Schema Definition 
• Schema Definition Report 

Schema Migration 
• 2020 Schema Migration Check 
• 2021 R2 Schema Migration Check 

SDD 
• SDD Report (by Component) 
• SDD Report (by Package) 
• SDD Report (by Project) 

SSDD 
• SSDD Report 

SSS 
• SSS Report 

TABLEMaker 
• General Concerns Report 
• Open Concerns Report 
• TABLEMaker 
• TABLEMaker (5 Attrib)  

 



 

 

 

 2270 Kraft Drive, Suite 1600 
Blacksburg, Virginia 24060 

+1 540 951 3322 | Fax: +1 540 951 8222 
www.vitechcorp.com 

 
Customer Support: 

+1 540 951 3999 | support@vitechcorp.com 

https://www.vitechcorp.com/
mailto:support@vitechcorp.com

	1. Getting Started With GENESYS
	The Benefits of GENESYS
	Installing GENESYS
	Overview of the GENESYS Product Family
	GENESYS
	GENESYS Pro
	GENESYS Server

	Key Concepts
	Integrated System Design Repository
	Comprehensive Systems Design Language™ (CSDL™)
	Dynamic Graphical View Generators
	Eliding (Hiding) Diagram Content
	Standard Display Mode
	Marked Display Mode
	Hidden (with Label) Display Mode
	Hidden Display Mode
	Automatic Document Generation


	2. Examining GENESYS
	The Sample Problem: Geospatial Library
	Guided Tour Conventions
	Getting Started with GENESYS
	Importing GENESYS Data
	The Main GENESYS Window
	Browser
	Model Assistant and Model Assistant Rules
	Use Case Rule Examples
	State Rule Examples

	Entity Property Sheet
	Accessing a Graphical View
	Saving GENESYS Data
	Saving Data in the Local or Server Repository
	Saving Data to a GENESYS Server
	Saving Data to GNSX

	Importing a Package

	3. Starting a GENESYS Project
	The Sample Problem: Geospatial Library
	Summary of the Typical Top-down Process
	Capturing the Problem and Source Requirements
	Loading the Source Document
	Parsing the Document

	Identifying Other Entities
	Defining a Relationship
	Extracting the Child-Level Originating Requirements
	Viewing a Traceability Spider or Hierarchy Diagram
	Adding Entities in a Traceability Spider Diagram
	Replacing Icons with Graphics
	Capturing Requirements Concerns

	4. Defining the System and its Boundary and Building the Behavior Model
	Defining the System Environment
	Creating Function Entities
	Relationships to Lower-Level Decomposed Items and Higher-Level Ancestors
	Easily Identifying Parent-Child Relationships in Models with Up and Down Arrows
	Adding Inheritance to Save Time Constructing Models
	Inserting a Parallel Structure
	Adding Functions to an Activity Diagram
	Adding Inputs and Outputs
	Deriving the Behavior for Our System
	Adding Inputs and Outputs in an Activity Diagram
	Boolean Triggering Relationship Attribute
	Adding to the Traceability

	5. EDITING FREE-FORM DIAGRAMS
	Route Lines
	Distribute Lines

	6. Completing the Physical Model
	Extending the Component (Physical) Hierarchy
	Allocating the Functions
	Completing the Physical Model
	Impact Analysis
	Ensuring Full Traceability from Source Document to Physical Architecture
	Selecting the Scripting Language
	Change Control

	7. CREATING CUSTOMIZED VIEWPOINTS OF THE DATA MODEL
	Masks
	Creating a New Mask
	Deleting a Mask

	Mappings
	Creating a New Mapping
	Creating a New Global or Local Mapping Item
	Deleting a Mapping Item
	Deleting a Mapping

	Filters
	Creating a New Filter
	Sorting Filter Criteria
	Deleting Filter Criteria
	Deleting a Filter

	Viewpoints
	Creating a New Viewpoint
	Sorting Filters
	Deleting a Viewpoint

	Rule Sets
	Creating a New Rule Set
	Deleting a Rule Set
	Creating a New Rule
	Sorting Rules, Rule Conditions or Rule Actions
	Deleting a Rule, Rule Condition or Rule Action
	Duplicating a Mask/Mappings/Viewpoint/Filter/Rule Set
	Applying a Rule Set to a Diagram

	Rule Set Diagram Legends
	Generating RDF Files with Viewpoints

	8. creating Multiple Views of a Diagram
	Creating a New View Based on the Default View
	Creating a New View Based on Another Formatted View
	Viewing All Available Views for a Diagram
	Displaying View Metadata
	Preventing Accidently Overwriting a View
	Saving a Diagram as an Image
	Displaying Multiple Diagram Views on Reports

	9. Structured Views of Diagrams
	10. Table Views
	11. Matrix Views
	12. Generating Documentation
	Generating a System Description Document (SDD)
	Generating TeamView
	Congratulations!

	13. Standard Reports Available in GENESYS

